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INTRODUCTION 
  

 

‘Introduction to Computing’ is an introductory course on computers and its related fields. It 

gives to the students the elementary knowledge of various computer related courses, which 

they study throughout the four years of their stay at the university. Putting it the other way, 

this course helps students make themselves acquainted with computer and information 

systems engineering. The objective of the practical work presented in this workbook is to 

provide necessary laboratory assistance to the students regarding this course. This workbook 

comprises of four sections. 

 

The first section introduces some basic concepts about various operating systems. Initial two 

laboratory sessions cover MS-DOS commands, the fundamental concepts and the powerful 

features that DOS provides for the system and to its users. The next laboratory session 

discusses Windows NT utilities and why Network sharing is important and how it can be 

achieved. Finally the students will be introduced about the Linux operating System and its 

basic commands in the last laboratory session of this section. 

 

Second section helps in exploring MS-Office 2010, various features of different application 

software part of it which are helpful to a common computer user. This includes Microsoft 

Word, Excel, PowerPoint and Access. Learning these software can help students in better 

documentation, preparation of their presentations and report work for various courses. 

 

Third section covers Computer Hardware. First laboratory session of this section teaches how 

to configure CMOS configuration and restore it when lost. The next two laboratory sessions 

introduce the basics of digital logic design. Here students learn the operation of basic logic 

gates’ ICs and their use to implement various logic functions on breadboard. It also includes a 

laboratory session to demonstrate various hardware components of a computer, its peripheral 

devices and its assembly. 

 

Fourth section starts with covering historical review and basic internet terminology. Finally 

some network wired media is discussed and demonstrated along with the various components 

and connectors used in building a computer network. 
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Lab Session 01 
 

OBJECT 
 

Familiarization with DOS environment and its important commands. 

 

WORKING WITH DOS 
 

Understanding DOS 
 

DOS, the acronym for Disk Operating System, is an operating system with a command-line 

interface used on personal computers. It provides a set of commands that enables the users to 

access or manipulate information on their disks, as well as simply interact with their 

computer.  

 

Dos Commands 
 

 

 

 

 

DOS commands are of two types namely internal commands and external commands. 

• Internal commands are those which are built into command.com.  

• External commands are those that must be located from a file loaded by command.com 

before it can be executed.  
 

A brief description of important DOS commands is given below: 

 

Changing drive 
 

Type drive letter of the drive to which you want to switch to, on the command prompt 

followed by ‘:’ 

Example: c:>d:     This will change the current drive from C to D. 

Result: d:> 

Figure 1.1: DOS environment 
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Wild Cards 
 

DOS recognizes two wild cards: 

• The asterisk (*) represents one or more characters that a group of files has in common. 

• The question mark (?) represents a single character that a group of files has in common. 

 

Working with Directories 
 

• dir    to view the contents of a directory 

Prompt on screen: drive:> 

Syntax: dir 

Example: c:>dir This will list all the files and subdirectories on drive C, which is  

being prompted on screen. If another drive needs to be 

accessed, first change the drive, as previously explained and 

then enter the dir command. 
 

      Use wild cards to display selected lists. For example: 

            - dir *.*                     Displays all files and subdirectories on the drive 

            - dir ?????.com Displays all files having names up to five characters and 

extension ‘com’ 
 

      dir command can be modified using these wild cards and other switches as follows so  

      that only one screen of selected information is displayed at a time. 

       - dir/p     Lists the directory contents page wise. 

       - dir/w Lists the directory contents in a wider format, that is, only file names  

and extensions. 

      - dir/w/p Lists the directory contents in a wider format, page wise. 
 

• cd    to change from one directory to another  

      Prompt on screen: drive:> 

Syntax: cd drive:\path 

      Example: c:>cd dos This will change the current directory from the root directory to  

‘dos’ directory on the prompted drive C. 

      Result: c:\dos> 
 

• md    to create a new directory 

Prompt on screen: drive:>       

Syntax: md drive:\path\dirname 

      Example: c:>md neduet This will create a new directory, named ‘neduet’ on the  

drive being prompted, in this case drive C. 
 

• cd..    to switch back one level up in the directory structure 

Prompt on screen: drive:> 

      Syntax: cd.. 

      Example: c:\dos\subdos>cd.. This will switch back to the directory, ‘dos’  

from the current directory, ‘subdos’ of the 

prompted drive C. 

      Result: c:\dos> 
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• cd\     to switch back to the root drive directory 

Prompt on screen: drive:> 

      Syntax: cd\ 

      Example: c:\dos\subdos>cd\ This will switch back to the root drive, C 

      Result: c:\> 

 

• rd      to remove a directory  

     Prompt on screen: drive:> 

Syntax: rd drive:\path\dirname 

     Example: c:\>rd neduet  

     This will delete the directory, named ‘neduet’ from the prompted drive C. 

 

Note that rd doesn’t delete  folders having subdirectories. For that purpose rd/s is to be 

used 
 

• tree      to view directory listing in a hierarchical structure. 

Prompt on screen: drive:>       

Syntax: tree drive:\path 

      Example: tree d: This will display the hierarchical directory structure of drive D. 
 

Use /f to display the names of the folders as well as the files in each folder, in a 

hierarchical manner. 

 

 

Working with Files 
 

• copy      to copy a file from one directory or drive to another  

Prompt on screen: drive:>       

Syntax: copy drive:\source path\filename   

drive:\destination path\ filename 

      Example:  copy c:\neduet\cfile.exe c:\windows    

This will copy the file, named ‘cfile.exe’ from ‘neduet’ directory to 

‘windows’ directory with the same name for the new file. 
 

• ren      to rename a file  

Prompt on screen: drive:>  

Syntax: ren drive:\path\old filename drive:\path\new filename 

      Example: c:\>ren cfile.exe edit.exe   

        This will rename the file ‘cfile.exe’ to ‘edit.exe’ in the prompted drive C. 
 

• del      to delete a file  

Prompt on screen: drive:>       

Syntax: del drive:\path\filename 

Example: c:\>del cfile.exe This will delete the file, ‘cfile.exe’ present in the 

prompted drive C. 

 

      Wild cards can also be used with any of the above commands to work with group of files. 
 

• type      to view a file on the screen. Only text based files can be viewed, as DOS supports  
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       only such files. 

Prompt on screen: drive:>       

Syntax: type drive:\path\filename 

      Example: c:\>type cfile.txt    This will list ‘cfile.txt’. 
 

Files longer than one screen scroll off to the top. To avoid this, use |more suffix 

following the command.  

      Example: c:\>type cfile.txt |more  
 

Disk Management 
 

• format      to format a disk  

Prompt on screen: drive:>       

Syntax: format drive: 

      Example: c:\>format Z:    This will format Flash memory stick in drive Z. 
 

• chkdsk      to get a report on statistics of the disk  

Prompt on screen: drive:>       

Syntax: chkdsk drive: 

      Example: c:\>chkdsk c:    This will generate a report on statistics of  drive C.  
 

• vol      to view a disk’s volume label and it’s serial number 

Prompt on screen: drive:>       

Syntax: vol drive: 

      Example: c:\>vol d:    This will display volume label of drive d.  
 

• ver      to find current version of DOS installed on your system  

Prompt on screen: drive:>       

Syntax: ver 

      Example: c:\>ver    This will display the current version of DOS on your system.  

 

Tip: 

You can take help for any DOS command by typing command name followed by /? 

e.g.  
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EXERCISE 
 

1. Write command to display all files having extension ‘docx’. 

 

Ans: ______________________________________________________________________ 

 

2. Write command to display all files of all types starting with letter ‘s’. 

 

Ans: ______________________________________________________________________ 

 

3. Write a command to copy the file assignment of type docx from the directory ‘ITC’ of 

drive D to another directory “FCE” in drive F. 

 

Ans: ______________________________________________________________________ 

 

 

4. Write a command to delete the directory as well as the files of the directory ‘world’ on 

drive E. 

 

Ans: ______________________________________________________________________ 

 

5. Write command to copy all the files beginning with ‘m’ and whose file names has a 

‘txt’ extension from drive A to the ‘\document’ directory on drive C. 

 

Ans: ______________________________________________________________________ 

 

6. Write set of commands to create a directory ‘practical’ on drive F, and then move into 

it. Now list all files present in it, then go back to root drive F. 

 

Ans: ______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________ 

     ______________________________________________________________________
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Lab Session 02 
 

OBJECT 
Learning some configuration commands and creating Batch files in DOS environment. 

 

CONFIGURATION COMMANDS 
 

• doskey      to recall previously generated DOS commands, first it should be enabled,  

which is done by using doskey command.  

Prompt on screen: drive:> 

      Syntax: doskey     

      Example: c:\>doskey    This will install doskey. 

 

     Now use UP and DOWN ARROWS to recall commands; ESC clears command line; F7  

displays command history; ALT+F7 clears command history; F8 searches command 

history; F9 selects a command by number. Make sure the Office key is disabled on 

keyboard; otherwise these keys will not perform the tasks correctly. 

 

• date      to set date of the system  

      Prompt on screen: drive:> 

Syntax: date mm/dd/yy     (or use ‘-’ in place of ‘/’)          

      Example: c:\>date 5-16-2011   This will set date to May 16, 2011. 

 

• time      to set time of the system using the 24 hour clock representation 

      Prompt on screen: drive:> 

Syntax: time hh:mm:ss           

      Example: c:\>time 14:33   This will set current time to 2:33 pm. 

 

• cls      to clear the screen  

Prompt on screen: drive:> 

Syntax: cls           

  Example: c:\>cls    This will clear the screen and bring the cursor to the top. 

 

• prompt      to set system prompt  

Prompt on screen: drive:> 

Syntax: prompt prompt name  

      Example: c:\>prompt neduet:    This will set the current prompt to neduet: 

      Result: neduet:  

 

      To get back to standard default system prompt, type prompt without parameters. 

      Use the following switches anywhere in the prompt command to incorporate special        

information: 

      -  $t to get the current time 

      -  $d to get the current date 

      -  $p to get both the active drive and directory 

      -  $n to get the active drive only 
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      -  $g to represent the character ‘>’ 

      -  $l to represent the character ‘<’ 

      -  $b to represent the character ‘|’ 

      

      Example: c:\>prompt time is $l$t$g 

      Result: time is <14:02:10> 

 

• path      to set the default command search path  

Prompt on screen: drive:> 

      Syntax: path drive:\pathname1   

       

Use ‘;’ to specify more than one search paths     

      Example: c:\>path c:\neduet;c:\float 

      This will tell DOS to search for programs in neduet directory, then in float directory. 

 

 

• color   sets the default console foreground and background color 

Prompt on screen: drive:> 

Syntax: color [attr] 

     Here, attr specifies the color attribute of the console output. Color attributes 

are specified by two hex digits. The first corresponds to the background, the second to the 

foreground. Each digit can be any of the following values: 

                   0     Black    8     Gray 

                   1     Blue    9     Light Blue 

   2     Green               A    Light Green 

                   3     Aqua               B    Light Aqua 

                   4     Red               C    Light Red 

                   5     Purple                                      D    Light Purple 

                   6     Yellow                                     E    Light Yellow 

                   7     White               F    Bright White 

 

      Example: c:\>color 1E     This will set the background color to blue and text color  

to light yellow. 

 

 If only one digit is used with the command, it assumes 0 for the background color, which 

is black, and the mentioned digit for the foreground color. 

 Example: c:\>color 2 This will set the background color to black and text  

color to green. 

 

• exit      to exit from DOS shell  

Prompt on screen: drive:> 

Syntax: exit      

      Example: c:\>exit    This will close the DOS window 

             

DOS HELP 
 

• Type help at the command prompt to display DOS Help table of contents. 
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• Type help followed by the command name to view information about a command. 

      For example: c:\>help copy  This will display information about the ‘copy’  

command. 

The command name can also be followed by /? to view information about a command. 

      For example: c:\>copy/?    This will display information about the copy command. 

 

MAKING BATCH FILES 
 

A batch program of a batch file is a text file that contains a series of commands that DOS 

carries out when its name is typed at the command prompt. 

 

AUTOEXEC.BAT file is an example of such files. It is a special batch program that runs every 

time you start your computer. It starts necessary programs and does settings at the startup. To 

make a batch file, apply the following steps: 

• Open a new text file in an editor (DOS editor, ‘EDIT’ can be used by typing edit 

command at the command prompt to open this editor). 

• Type DOS commands, which are to be included in the batch program in this text file.   

Each command is typed on a different line. 

• Save the file with suitable name provided that its extension is bat. For example, 

mybatch.bat 

 

BATCH FILE COMMANDS 
 

• echo  This command directs DOS whether or not to display the commands in a batch  

file or not.  

Syntax: echo on/off 

      An alternate is to insert @ sign before the command. 

Example: @dir    This command, if included in the batch file will prevent dir command  

from displaying on the command prompt.  

 

• call This command calls one batch program from another.  

Syntax: call [drive:][path]filename  

Example:  Create a batch file named one.bat with command dir/p. Then make  

another batch file named two.bat with the following two commands: 
      call one.bat 

help          

        From DOS prompt run two.bat 

Syntax: two.bat 

Result: This will display the directory listing, page wise, and then the help file. 
 

• pause This command suspends processing of a batch program and displays the  

message: Press any key to continue...  

 Syntax:  pause  

Example:  Create a batch file named one.bat with command dir/p. Then make 

another batch file named two.bat with the following two commands: 

    call one.bat          

         pause        
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    help      

        From DOS prompt run two.bat 

Syntax: two.bat 

Result:  This will display the directory listing page wise, then pause and wait for a key  

       from the user and on receiving a key, it will display the help file. 

 

• rem This command records comments <remarks> in a batch file 

Syntax:  rem [comments]  

Example:  Create a batch file named remark.bat with the following commands: 

                   dir/p 

rem moving to root directory    

         cd\ 

        From DOS prompt run remark.bat 

        Syntax: remark.bat 

Result: This will display the directory listing page wise, it will then print the remark  

      “moving to root directory” and will then move to the root directory. 

   

• goto  To switch to another part of a batch program, use the goto command and a  

label. The label (preceded by a colon) must appear on its own line elsewhere in 

the batch program. 

Example:  goto skipdown 
       echo this comment command will be skipped 

       :skipdown 

       doskey 

Result: The echo command will be skipped. 

 

EXERCISE 
 

1. Write a command to change the command prompt to ‘Good Morning:\>’. Write another 

command using ‘$’ to switch back to the standard C prompt (C:\>). 

 

Ans:  First Command:  _______________________________________________ 

 

Secondf Command: ________________________________________________ 

 

2. Write a command to set the system date to Jan 16th, 2018 

 

Ans: ______________________________________________________________________ 

 

3. Make a batch file called first.bat, which includes commands to display directory 

listings of drive F, then remove a directory called “new” from the same drive. Do not 

switch into the drive. 

 

Ans: ______________________________________________________________________ 

______________________________________________________________________ 

______________________________________________________________________
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Lab Session 03 

OBJECT 

Understanding network sharing and working with Windows 7 

 

THEORY 
 

COMPUTER MANAGEMENT OVERVIEW 

 

Computer Management is a collection of administrative tools that you can use to manage a 

single local or remote computer. It combines several administration utilities into a console 

tree, and it provides easy access to administrative properties and tools. 

You can use Computer Management to: 

 

• Monitor system events, such as logon times and application errors. 

• Create and manage shared resources. 

• View a list of users connected to a local or remote computer. 

• Start and stop system services, such as Scheduled Tasks and Indexing Service. 

• View device configurations and add new device drivers. 

• Manage applications and services. 

 

OPENING THE COMPUTER MANAGEMENT CONSOLE 

 

 
Fig 3.1 Computer Management 

  

• To open Computer Management, click Start, and then click Control Panel→ System 

and Security→ Administrative Tools→ Computer Management Or 

• Go to start →Run and write “compmgmt.msc “and click OK. 

Computer Management contains three items: 

1. System Tools 

2. Storage 

3. Services and Applications (not to be discussed in this course) 
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1. SYSTEM TOOLS 

 

Systems Tools is the first item in the Computer Management console tree. You can use the 

following default tools to manage system events and performance on the target computer  

 

• Task Scheduler 

• Event Viewer 

• Shared Folders 

• Local Users and Groups 

• Performance (Logs and Alerts) 

• Device Manager 

 

 
Figure 3.2 System Tools 

 

USING TASK SCHEDULER 

 

You can use task scheduler to create and manage common tasks that your computer will carry 

out automatically at the times you specify. To begin, click a command in the Action menu. 

Tasks are stored in in folders in the Task Scheduler Library. To view or perform an operation 

on an individual task, select the task in the Task Scheduler Library and click on a command in 

the Action menu. 

 

USING EVENT VIEWER 

It can be used to view events that have occurred on your computer, select the appropriate 

source, log or custom view mode in the console tree. The administrative Events custom view 

contains all the administrative events regardless of source. An aggregate view of all the logs 

of some machine is shown in figure 3.3 
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Figure 3.3 Event Viewer 

 

USING SHARED FOLDER 

 

You can use Shared Folders to manage shared resources on both local and remote computers. 

Windows Explorer and the command line allow you to manage shared resources on your local 

computer only. 

 

To share a folder or drive 

1. In the console tree, click Shares. 

 [ Computer Management→System Tools→Shared Folders→Shares ] 

2. On the Action menu, click More Actions→New Share… 

3. Follow the steps in Create A Shared Folder Wizard. 

4. You will be prompted to select a folder or drive, type a new share name and description 

of the shared resource, and set permissions. After you provide this information, click Finish. 

[Note: A shared folder is available to a particular user(s) on entire network.] 

To set permissions on a shared resource 

1. Right-click the shared resource for which you want to set permissions, and then click 

  Properties. 

2. On the Share Permissions tab, select the following options that you want, and then click 

    OK: 

• Click Add to grant a user or group permission for a shared resource. In the Select 
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  Users, Computers, or Groups dialog box, look for or type the user, computer, or  

 group name, and then click OK. 

• Click Remove to revoke access to a shared resource. 

• In Permissions for <group or user>, select the Allow or Deny check boxes to set 

 individual permissions for the selected user or group. 

 

To stop sharing a resource 

In the details pane, right-click the folder that you want to stop sharing, and then click Stop 

Sharing. 

 

You can directly right click on a file or folder name and then select share with to share it 

among users at same computer 

 

LOCAL USERS AND GROUPS OVERVIEW 

 

Local Users and Groups is a tool you can use to manage local users and groups by  

• Create a new user account / group 

• Modify a user account / group 

• Change the password for a user 

• Disable or activate a user account / group 

• Identify members of local groups 

• Delete a user account / group 

• Rename a user account 

 

To create a new user account  

1. On the Action menu, click New User. 

2. Type the appropriate information in the dialog box. 

3. Select or clear the check boxes for: 

 

• User must change password at next logon 

• User cannot change password 

• Password never expires 

• Account is disabled 

 

4. Click Create, and then click Close. 

 

To modify a user account / group 

1. Right-click the / group you want to modify, and then click Properties. 

2. Make the changes you want, and then click OK. 

 

PERFORMANCE  

 

With Performance Monitor you can collect performance data automatically from local or 

remote computers. You can view logged counter data using System Monitor or export the data 

to spreadsheet programs or databases for analysis and report generation. Performance Monitor  

offers the following operations: 

• Counter data collected by performance Logs and Alerts can be viewed during collection as 

  well as after collection has stopped. 
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• Because logging runs as a service, data collection occurs regardless of whether any user is 

  logged on to the computer being monitored. 

• You can define start and stop times, file names, file sizes, and other parameters for 

  automatic log generation. 

• You can manage multiple logging sessions from a single console window. 

• You can set an alert on a counter, specifying that a message be sent, a program be run, an 

entry be made to the application event log, or a log be started when the selected counter’s  

value exceeds or falls below a specified setting. 

 

Logs and Alerts also offers other options related to recording performance data. These 

include: 

• Start and stop logging either manually on demand, or automatically based on a user 

  defined schedule. 

• Configure additional settings for automatic logging, such as automatic file renaming, 

  and set parameters for stopping and starting a log based on the elapsed time or the file  

 size. 

• Create trace logs. It traces logs record detailed system application events when certain 

  activities such as a disk input/output (I/O) operation or a page fault occurs.  

 

DEVICE MANAGER 

 

Device Manager provides you with a graphical view of the hardware that is installed on your 

computer. (See figure 3.4) You can use Device Manager to update the drivers (or software) 

for hardware devices, modify hardware settings, and troubleshoot problems. Device Manager 

is typically used to check the status of your hardware and update device drivers on your 

computer. Advanced users who have a thorough understanding of computer hardware might 

also use Device Manager’s diagnostic features to resolve device conflicts and change resource 

settings. 

 

You can use Device Manager to: 

• Determine whether the hardware on your computer is working properly. 

• Change hardware configuration settings. 

• Identify the device drivers that are loaded for each device, and obtain information about  

 each device driver. 

• Change advanced setting and properties for devices. 

• Install updated device drivers. 

• Disable, enable, and uninstall devices. 

• Roll back to the previous version of a driver. 

 

View the status of a device 

1. Click Device Manager. 

2. Double-click the type of device you want to view. 

3. Right-click the specific device you want, and then click Properties. 

4. On the General tab, under Device status is a description of the device status. 

 

Enable / Disable device 

1. Open Device Manager. 

2. Double-click the type of device that you want to Enable / Disable 
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3. Right-click the specific device you want, and then click Enable / disable. 

 

 
Fig. 3.4   Device Manager 

 

Uninstall a device 

1. Open Device Manager. 

2. Double-click the type of device that you want to uninstall. 

3. Right-click the specific device you want to uninstall, and then click Uninstall. 

4. In the Confirm Device Removal dialog box, click OK. 

5. When you are done uninstalling the device, turn off your computer, and remove the device 

  from the computer. 

 

2. STORAGE  

 

Storage displays storage device that are installed on the computer that you are managing. You 

can use the default following tools to manage the properties of storage devices. 
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Disk Management 

 

You use Disk Management (See fig. 3.5) to perform disk-related tasks, such as creating 

partitions and volumes, formatting them, and assigning drive letters. 

 

 
Fig 3.5 Disk Management 

 

 

On different operating systems, you can also use Disk Management to perform advanced 

tasks, such as configuring software RAID. Other operations are; 

 

• Simplified tasks and intuitive user interface: Disk Management is easy to use. Menus  

 that are accessible from the right mouse button display the tasks you can perform on the 

 selected object, and wizards guide you through creating partitions or volumes and  

 initializing or converting disks. 

• Basic and dynamic disk storage: Basic disks contain basic volumes, such as primary 

 partitions, extended partitions, and logical drives. Use basic disks on portable computers 

 or when you plan to install multiple operating systems in different partitions on the same  

 disk. 

 

Dynamic disks contain dynamic volumes that offer features not available in basic disks, such 

as the ability to create fault-tolerant volumes (RAID). 

• Local and remote disk management: By using Disk Management, you can manage any  

 remote computer running a compatible Windows OS, on which you are a member of  

 the Administrators group. 

 

For example, if you want to allow your system to be remotely accessed, go to My Computer, 

then Select Properties by right clicking anywhere on this window. Now Select Remote 

Settings Tab (See fig. 3.6) and select appropriate radio button (middle one is preferred). 
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Fig. 3.6 Allowing Remote Desktop Access 

 

In order to remotely access a desktop, type Remote Desktop Connection in search bar  or 

mstsc.exe in Run, a window will appear, just give name of the computer, to which you want 

to get connected, followed by the password. Now a Desktop of that computer will appear on 

your monitor.  

 

• Mounted drives: You can use Disk Management to connect, or mount, a local drive at 

 any empty folder on a local NTFS-formatted volume. Mounted drives make data more 

 accessible and give you the flexibility to manage data storage based on your work 

 environment and system usage. Mounted drives to access more than 26 drives on your 

 computer. 

 

• Logical Disk Manager Service: The Logical Disk Manager Service uses disk groups to 

 maintain information about the current state of disks in your computer. 

 

 

Manage basic volumes 

   

Viewing the properties of a volume 

• In Disk Management, right-click the partition, logical drive, or other basic volume, 

 and then click Properties. 

 

Assign, changing or remove a drive letter 

• Right-click a partition, logical drive, or volume, and then click Change Drive Letter 

 and Paths 

• Do one of the following: 
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o To assign a drive letter, click Add, click the drive letter you want to use, and then 

 click OK. 

o To modify a drive letter, click it, click Change, click the drive letter you want to 

 use, and then click OK 

o To remove a drive letter, click it, and then click Remove. 

  

Create a mounted drive 

• Right-click the partition or volume you want to mount, and then click Change Drive 

 Letter and Paths. 

• Do one of the following: 

o To mount a volume, click Add. Click Mount in the following empty NTFS 

folder, type the path to an empty folder on an volume, or click Browse to locate it  

and then click OK. 

o To dismount a volume, click it and then click Remove. 

 

Mark a partition as active 

• Right-click the primary partition you want to mark as active, and then click Mark 

 Partition as Active. 

 

Format a basic volume 

• Right-click the partition, logical drive, or basic volume you want to format (or 

 reformat), and then click Format. 

• Select the options you want, and then click OK. 

 

Create a partition or logical drive 

• Right-click an unallocated region of a basic disk, and then click New Partition, or right 

 click in an extended partition, and then click New Logical Drive. 

• In the New Partition Wizard, click Next, click Primary partition, Extended partition,  

 or Logical drive, and then follow the instructions on your screen. 

Note: first create Primary Partition then extended. Logical Volumes are created with in the 

extended partition 

 

Delete a partition or logical drive 

• Right-click the partition, logical drive, or volume you want to delete, and then click  

 Delete Partition  

 

Note: First delete all Logical Partition and then Extended and Primary Partitions 

 

Disk Defragmenter 

 

Disk Defragmenter analyzes local volumes and consolidates fragmented files and folders so 

that each occupies a single, contiguous space on the volume. As a result, your system can 

access files and folders and save new ones more efficiently. By consolidating your files and 

folders, Disk Defragmenter also consolidates a volume’s free space, making it less likely that 

new files will be fragmented. The process of consolidating fragmented files and folders is 

called defragmentation. 

To defragment a particular disk or partition, select and right click on it, then select Properties 

and go to tab Tools, here you can find options for Disk Defragmentation. (See fig. 3.7)  
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These days a scheduled task of Disk fragmentation is already present. So you will not find 

your disk defragmented. 

 

 
Fig 3.7 Disk Defragmentation 

 

 

EXERCISE 

 

1. Use Task Scheduler utility to daily prompt a Good Morning message on your screen at 9 

a.m. List steps of accomplishing the above task. 

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________ 

2.  Your computer is giving warning for low disk space that means your containing the 

operating system software does not have enough space to ensure reliable system operations 

List various ways by which you can increase your disk space. 

________________________________________________________

________________________________________________________
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________________________________________________________

________________________________________________________

________________________________________________________ 
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Section Two 
 

Working with MS Office 2010 
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Lab Session 04 

OBJECT 

 

Learning basics of Microsoft Word 

 

WORD PROCESSING CONCEPTS 

 

Microsoft Word is designed to be user friendly. So, the MS Word often has more than one 

way to achieve much the same thing. 

 

To start a document, type the first few paragraphs of text. Don't worry yet about formatting or 

fonts or making text bold. 

 

Obviously the text we have on the screen so far isn't what we have in mind for a nicely 

formatted document. We need to make the Title and the Headings large and bold. And, we 

need space after the paragraphs. We need colors, pictures, diagrams etc. in a nicely formatted 

document. 

 

To achieve that, you can use formatting options discussed below. 

 

Case Changing 

 

To change case, select the text whose case to be changed; Press Shift+F3 to change the case. 

Each time F3 is pressed the user will toggle through three options: UPPERCASE, lowercase, 

and Title Case.  

 

Indentation 

 

To indent both the left and right sides of the paragraph, position the insertion point in the 

paragraph to be indented, or select multiple paragraphs to indent; Choose Page Layout, type 

or select a value in the Left and then the Right indentation text boxes. You can also increase 

or decrease the indentation by clicking on the up and down arrows beside the text boxes. 

 

Text Alignment  

 

Word automatically aligns text on the left margin (horizontal alignment) and to the top margin 

(vertical alignment). The user can choose to change the alignment to center, right, full 

justified, or back to left.  

 

To change horizontal alignment, select the paragraph(s) to be changed; Press Ctrl+L (Left), 

Ctrl+E (Center), Ctrl+R (Right), or Ctrl+J (Justify) to change the alignment of the paragraph 

accordingly (or use the Align Left, Center, Align Right, or Justify buttons on the Standard 

toolbar).  

 

To change vertical alignment, move the insertion point inside the section where the text is to 

be aligned; Choose Page Layout, Align. Select Center, Justify, or Top to change alignment.  
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Borders, Lines, and Shading 

 

For a finished look, the user can add borders and shading to the documents.  Just select the 

paragraph(s) to apply a border or shading to, then choose Insert, Table and click on Insert 

Table. In the title bar, there appears a Table Tools box. Click on this box. Click on Border and 

then on Border and Shading.  Then click the desired line style; Click the Line Weight button, 

then click the line weight to be used; Click the drop-down arrow on the Borders button, then 

click the type of border to be applied; Click the drop-down arrow on the Shading Color button 

to display the palette of gray percent and colors, then click the percent of gray or color button.  

 

Columns 

 

To create columns of equal width, choose Page Layout; Select the text (or to format the entire 

document with columns, select the document); On the Standard toolbar, click the Columns 

button; Drag the pointer to select the number of columns needed. To remove columns, select 

the text for the columns to be removed; Click the Columns button on the Standard toolbar and 

select one column.  

 

Drop Cap 

 

A drop cap is large capital letters of the first word that is set into a paragraph to add visual 

interest. Just select the first letter, word, or section of the paragraph to be formatted with a 

drop cap; Choose Insert, Drop Cap; Select Dropped or In Margin; In the Drop Cap Options 

section, select the Font from the drop-down list, and increase or decrease the Lines to Drop if 

the default of three lines is not to be used; If the distance of the text from the drop cap is to be 

changed, use the increment buttons on the Distance from Text option, then choose OK. To 

remove drop caps, click the drop caps text, choose Drop Cap, click the None option in the 

Position section of the dialog box, then choose OK.  

 

Customizing Paragraph Spacing 

 

The user can customize the paragraph spacing in Word for the spacing between paragraphs 

and the spacing between the lines in specified paragraphs.  To do this, place the insertion 

point in the paragraph to be modified, or highlight all of the contiguous paragraphs to be 

changed and right click on it; Choose Paragraph to display the dialog box, then click the 

Indents and Spacing tab if it is not active; In the Spacing section, select Before and After and 

change the value(s) in the text box to increase or decrease by points the number of lines 

before or after a paragraph (6 points = 1 line); To change the line spacing within paragraphs, 

select the drop-down arrow for the Line Spacing list box, then select one of these options: 1.5 

lines, Double, At least, Exactly, or Multiple; If one of the last three options is chosen, enter a 

number in the At text box. When finished, choose OK.  

 

Changing Default Tabs 

 

To change default tabs, click on the small arrow in the bottom right of Paragraph portion to 

display the dialog box. Click on the Tabs button in the dialog box. In the Tabs dialog box; To 

change the default tab stops to a different setting, click in the Default Tab Stops field and 

enter the new value, for example enter .25". Tab stops will be set every quarter inch based on 
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these settings; Click OK to close the dialog box and apply the new tab stops settings to the 

Ruler.  

 

Inserting Special Characters 

 

To insert special characters, place the insertion point at the point in the paragraph where a 

symbol or special character is to be placed; Choose Insert, Symbol to display the Symbol 

dialog box. Click the Symbols tab to select a symbol, or click the Special Characters tab to 

select a special character; On the Symbols tab, select the font set that contains the symbol to 

be inserted in the document in the Font drop-down list box. To view a symbol in the displayed 

table, click the symbol. The symbol is then displayed in an enlarged and highlighted view; To 

insert a symbol or special character, click the item to be inserted, then click the Insert button. 

Click the Close button to close the dialog box and return to the document.  

 

Zooming the Document Display 

 

Zooms customizes the on screen size of the document in a way the user wants to view it. 

However, zoom setting does not affect the actual formatting of the document. To adjust 

zooming option, click View, Zoom; In the drop-down list, select the zoom percentage to be 

used. The document display changes to the zoom percentage selected; If the required zoom 

percentage is not in the list, type the percent in the text box part of the Zoom button and press 

Enter.  

 

Creating Custom Colors/Gradients/Textures 

 

To create custom colors, right click on the graphic element to be colored. Along with the 

shortcut menu appears the Drawing toolbar. Then click the drop-down arrow of the Fill Color 

or Line Color button and select More Fill Colors to open the Colors dialog box; Click the 

Custom tab at the top of the Colors dialog box. Set desired color. For gradient settings, in the 

drop-down arrow beside the Fill Color button, select Gradient at the bottom of the color 

palette instead of More Fill Colors.  Click the Gradient tab and make desired settings. Texture 

tab can also be selected to apply designs to the objects. 

 

Inserting Clip Art/AutoShapes/Pictures/WordArt 

 
To insert a Clip Art/ AutoShape, Picture or WordArt, position the insertion point in the 

document where the image is to be appeared. Choose Insert and then the desired option. 

Related dialog box appears, then make required selections. The inserted object can be 

customized in a number of ways. The user can change colors of the image, edit, reposition and 

resize them. 

There are two ways to rotate or flip the inserted object. One is to right click on the object and 

then choose Format Picture/Shape. Then click on the 3-D Rotation button. From here, the 

desired rotation in the x, y and z axes may be chosen. The other gives access to that same tool 

and to the commands Rotate Left, Rotate Right, Flip Horizontal, and Flip Vertical. To do this, 

click the object to be adjusted choose Page Layout, click on Rotate and then choose the 

desired option. 

 

These commands automatically execute. If Free Rotate is chosen (if we bring the cursor on 

the small green circle that appears above any object when we select it, this gives the free 



Introduction to Computing                                                                       Lab Session 04 
NED University of Engineering & Technology – Department of Computer & Information Systems Engineering 

 

 

26 

rotate option) continue with the following steps; Move the pointer over the rotate handle and, 

when it assumes the shape of the rotate tool icon, hold down the right mouse button; The 

pointer changes to four circling arrows. Drag right or left. While dragging, a dotted outline 

indicates where the object would be if the mouse button is released; until the object is 

deselected it can be continuously rotated, even if the mouse button has been released. Place 

the pointer over a circle handle, hold down the mouse button and continue to rotate. Release 

the mouse button when the object is rotated to the desired position, and click outside the 

object to deselect it. 

 

Creating Headers and Footers 

 

Headers and footers contain information repeated at the top or bottom of the pages in a 

document. To set Header and Footer, with the document open, choose Insert, then click on 

Header or Footer. Choose the desired format from the drop down list. The Header pane is 

displayed in the document; Type and format the information for the header; To include the 

Page Number, Number of Pages, or current Date or Time, click the corresponding button on 

the Header and Footer toolbar; To create a footer, click the Go to Footer Button on the toolbar 

and type and format the footer just as was done for the header. Click Close Header & Footer 

button to return to the document.  

 

Document Map 

 

The Document Map is a very functional way to move quickly through long or online 

documents. To use Document Map, choose View, Navigation Pane. Use the mouse to click 

the heading or text in the Document Map pane to move to that section of the document; Click 

the arrow on the left of any heading to expand or collapse the headings; To adjust the size of 

the Navigation pane, move the mouse pointer onto the right edge of the pane so the pointer 

changes to a resizing pointer, then click and drag the edge to the left or right. To use the 

keyboard, press F6 to move to the Navigation pane. Arrow keys and the Enter key will move 

to the desired location in the document. 

 

Drawing Tables 

 

Drawing a table allows the user to place the rows and columns where he wants them. To 

create a table, click the Tables and Borders button to bring up the Tables and Borders toolbar 

and change the mouse pointer to a pencil; Drag the mouse pointer from one corner of the new 

table to the opposite corner to create the rectangle outline for the table; If a line is to be 

removed, click the Eraser button on the Tables and Borders toolbar and drag across the line.  

 

If the user needs the data from a table, he may (rarely) want to convert the table to text with 

some sort of separator between the data for the former columns. To do this, select the entire 

table by positioning the mouse directly at the left top of the table until the pointer changes to a 

four directional arrow and then click it. A Table toolbar appears at the top of the document 

window. In the Layout tab, choose Convert to Text. Choose to separate the text with 

Paragraph Marks, Tabs, Commas, or type a new character in the Other text box; then choose 

OK. Similarly the user may want to convert the lines of text into a table. To do this, select the 

rows of tabbed text to be converted; Choose Insert, click on Table and then choose Insert 

Table.  
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The cells of the table can be edited and formatted, like moving and copying cells, splitting and 

merging cells, adjusting row and column spacing/width, inserting and deleting rows and 

columns, by selecting appropriate options from the menu that appears on right clicking the 

table or the selected cells. 

 

EXERCISES 

 

• Write a report on any topic of your choice to show the maximum usage of Formatting 

features provided by MS Word. 

 

  

 

Attach the colored printout here.  
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Lab Session 05 

 

OBJECT 

 

Exploring the advanced features of Microsoft Word 

 

WORD PROCESSING CONCEPTS 

 

Paragraphs: Formatting Line and Page Breaks 

 

The user would not want to have one line of a paragraph appear on the bottom or top of a 

page alone. This is Widow and Orphan control. Select the paragraph that you want to prevent 

from breaking onto two pages. On the Page Layout tab, click the Paragraph Dialog Box 

Launcher, and then click the Line and Page Breaks tab. Select the Keep lines together check 

box. Keep with Next will prevent a page break between the selected paragraph and the 

following paragraph. Page Break Before will insert a manual page break before the selected 

paragraph.  

To insert page breaks, position the insertion point anywhere within the paragraph to be 

formatted, and choose Insert, and then click on Page Break. 

 

Sections Breaks 

 

Section breaks are important when the user need to apply different formatting choices to 

different parts of the document. To insert Section Breaks, position the insertion point where 

the section break is required, and then On the Page Layout tab, in the Page Setup group, click 

Breaks. Click the type of section break that you want to use. Different options are: Next Page-

to start section at the top of the next page in the document; Continuous-to start section at the 

insertion point (for varying columns on one page); Even Page-to start section on next even-

numbered page in the document (most often a left-facing page); Odd Page-to start section on 

next odd-numbered page in the document (most often a right-facing page). 

 

Use the Continuous section break to balance columns on a page. Insert the break at the end of 

a document that is divided into columns where the last column does not fill to the end of the 

page.  

 

To remove Section Breaks, press Ctrl+H to issue the Replace command, and then choose the 

More button to expand the Find and Replace dialog box; With the insertion point in the Find 

What text box, choose the Special button, and then select Section Break at the bottom of the 

list. Do not put anything in the Replace With text box; Choose Find Next to find the next 

section break. The section break is selected behind the dialog box. Continue searching by 

choosing the Find Next button, or remove this section break by choosing the Replace button; 

If all the section breaks are to be replaced, choose the Replace All button. Word will tell how 

many replacements were made; then choose the OK button and Close to return to the 

document. 
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Inserting Page Numbers 

 

To insert page numbers, choose Insert, Page Numbers to display the list box, select Bottom of 

Page (Footer), or Top of Page (Header) and choose from the given options to align the page 

number horizontally on the page; in the Header & Footer Toolbar Select the Different First 

Page check box if a page number is not to appear on the first page of the document or there is 

any other formatting required for the first page; To change format options, choose the Format 

Page Number button and select from the options on the Page Number Format dialog box; 

Choose OK to return to the Page Numbers dialog box, and then choose OK or Close to return 

to the document and save and apply the changes.  

 

Page numbering is continues throughout the entire document. There may be instances where 

the user need to number sections differently. For example, he may want to start each section 

with page 1. For this, divide the document into sections by inserting section breaks, and then 

position the insertion point in the section to apply unique numbering. Choose Insert, Page 

Numbers, and then choose the Format Page Number button. Make any changes to the options 

on the Page Number Format dialog box. To restart numbering for this section, in the Page 

Numbering section of the dialog box, click the Start At option and type or select the starting 

page number. Then choose OK to return to the document. Like page numbers, Headers and 

Footers also can be made different for different section. 

 

Page Setup 

 

Changing the default page layout formatting enables the user to choose whether the headers 

and footers are the same throughout the document, or change from odd page to even page. To 

change layout, select the header or footer to be formatted. This makes a toolbar appear at the 

top of the document window. Click one of the options: Different Odd and Even or Different 

First Page, depending on the needs for the headers and footers in the document; Select the 

Header/Footer drop-down arrow to choose between Top, Center, or Justified. 

 

To change margins, choose Page Layout. Click on the Margins drop down arrow, either select 

or type in the margins for all sides in Custom Margins, including the From Edge settings for 

the Header and Footer in the Layout tab.; If the user will be binding the document and want 

the inside margin to remain constant, click Mirror Margins to toggle that feature on and off; In 

the Apply To box, indicate to what portion of the document these changes are to be applied; 

When finished, choose OK. The default measurement units for margins are inches. To change 

units, choose File, click Options. Click Advanced tab. In the Display section, change the unit 

in the show measurement in units of text box. 

 

Paper size can also be changed. To change paper size, choose Page Layout and click on Size. 

Select an appropriate paper size from the drop down list; If the paper measurements are not 

included in the Paper Size box, type in the appropriate measurements in the Width and Height 

text boxes given in the Paper tab in the dialog box when we click on More paper sizes. In the 

Apply To box, indicate to what portion of the document these changes are to be applied; when 

finished, choose OK.  

 

The Paper Source tab tells the printer where to go to get the first page of a document and then 

where to go to get all subsequent pages. To choose paper source, on the same dialog box, 

select the Paper Source tab; In the First Page list box, select the location or source for the 
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paper of the first page of each document for the printer; In the Other Pages list box, select the 

location or source for the paper of all subsequent pages for the printer; In the Apply To box, 

indicate to what portion of the document these changes are to be applied; When finished, 

choose OK.  

 

Creating Bookmarks 

 

A bookmark is a named marker for a block of text, an entire table or a graphic, a cell or range 

of cells in a table, or simply a position in a document. First enter a bookmark where it is 

wanted, then the user can move to it or cite it as a reference in a field or formula.  To create a 

book mark, click in the document at the location where the bookmark is to be inserted, or 

select the text or graphic to be named; Choose Insert, Bookmark to display the Bookmark 

dialog box; enter the new bookmark name in the Bookmark Name text box. The user can also 

select an existing bookmark name from the list, and Word moves the bookmark from its 

existing location to the place selected; Click the Add button to add the bookmark to the 

bookmark list and close the dialog box.  

 

To delete a book mark, choose Insert, Bookmark; Select the name of the bookmark to be 

deleted from the Bookmark Name list box; Click the Delete button. The selected bookmark 

name is removed from the list box and the document; Click the Close button to close the 

dialog box and return to the document.  

 

Hyperlinks 

 

The user can create a link that jumps to a document, also called a page, on his computer and 

on a network or intranet.  Two types of hyperlinks can be created: one that jumps to a 

bookmark in the same document and another that jumps to a URL. 

 

First type is for named locations. Named locations can be in the same document the user is 

working with (an internal link), or in a different document (an external link). The named 

location targets a Bookmark inserted at the position to be jumped to within a document. To do 

this, use the Insert Hyperlink button on the Standard toolbar to open the Insert Hyperlink 

dialog box; choose either Place in this document or Existing File or Webpage button. Locate 

the Word document containing the Bookmark this link is to jump to. The user can also jump 

to a named range in Excel, a database object, or a specific PowerPoint slide; choose OK to 

confirm the choice or Cancel to negate it.  

 

Second type is for URLs and other links. For this click the Insert Hyperlink button on the 

Standard toolbar to open the Insert Hyperlink dialog box; click on the Browse the Web or 

Browse for File button to locate and select the document. The path and document name are 

automatically entered in the Address text box; choose OK to confirm the choice or Cancel to 

negate it.  

 

Mail Merge 

 

If the user is sending many documents, mail merge can save lots of time. The user can design 

a form that prints multiple labels on a page similar to the way he designs a form letter. 
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• Creating Main Document - A main document is a letter, envelope, or other document that 

has text that the user wants to appear on every merge, and codes that will be replaced with 

entries from a data source of names and addresses.  

To create the main document, open a new blank document window. Then choose 

Mailings, Mail Merge. In the drop down list select the Step by step Mail Merge Wizard to 

display the Mail Merge Helper. Select the document type under Step 1; then select the 

starting document. 

The wizard now asks to select recipients (data source-a location for names and addresses). 

Now there are two ways to get the data source. Either select from existing data sources or 

create a new list. 

 

• Opening a Existing List - The existing data source could be a Word document, an Excel 

document, an Access database or query, a dBASE file, or even a FoxPro file, as well as 

many others. For this, select the Use an existing list option and then browse. Word can 

read many different data source formats. Choose the drop-down arrow on the Files of 

Type list to select the file type for the data source; Navigate in the Look In list to find the 

drive and folder where the data source file is stored. Select the file and choose Open, or if 

available, click the MS Query button if a non-Word database is to be selected. 

 

• Creating a New List - If the user does not have a data source that contains list of names 

and addresses for the merge document, one can be created using the Type new list option 

and then click on Create. The New Address List dialog box is displayed; Scroll through 

the list of fields in the Field Names in Header Row list box to see commonly used field 

names provided by Word; Edit the list of field names using the Customize Fields button. 

The top-to-bottom order of the fields is the order the fields will be in for data entry in the 

data source. When finished, choose OK; Word displays the Save As dialog box. In the 

File Name box, enter a name for the data source document and choose Save. 

 

• Inserting Fields - Step four is to write the letter. The wizard helps to insert fields. Merge 

fields are the variable information that changes for each document. Position the insertion 

point where a merge field is to be appeared and then select the field from the list 

presented; Type any text or punctuation that is needed in the document and continue 

inserting merge fields where necessary.  

 
EXERCISES 
• Create a word document (Properly Formatted), using mail merge wizard, which produces 

individual information reports for a list of students in the form of a table, including their 

first name, last name, father’s name, home address, phone number, email addresses, and 

home page address as hyperlinks (if any). Enter few sample records. Table should be 

properly formatted. Remember to include your name and roll number in the header field. 

Get a printout to be attached here, of the page that contains only field name and not any 

records. Also attach 1 sample report containing actual data.  

 

Attach the colored printout here. 



Introduction to Computing  Lab Session 06 
NED University of Engineering & Technology – Department of Computer & Information Systems Engineering 

 

 32 

Lab Session 06  
 

OBJECT 
 

Working with Microsoft Excel 

 

WORKING WITH SPREADSHEETS 

 
 Figure 7.1: Excel Home window 

 

Entering Text 

 

Text entries can include a combination of alphabetical characters, numbers, and symbols. By 

default, when text is entered in a cell, the text automatically aligns on the left side of the cell. 

Occasionally, a number may be entered as a text entry.  To make Excel accept numbers as 

text, type an apostrophe (') followed by the number.  

 

Entering Numbers 

 

Numbers are constant values containing only the following characters: 0 1 2 3 4 5 6 7 8 9 + - ( 

) , / $ % . E e. User can enter integers, such as 24 or 973; decimal fractions, such as 908.37 or 

0.72; integer fractions, such as 3 1/4 or 2/3; or scientific notation, such as 5.87137E+3. (See 

also "Entering: Text" and "Entering: Dates and Times.") . By default, the numbers 

automatically aligns on the right side of the cell. 

 

To enter a fraction, type an integer, followed by a space, and then the fraction. If only the 

fractional part is to be entered, type a zero, a space, and then the fraction; otherwise Excel 

may interpret the entry as a date. 

Name 

Box 
Formula 

Bar 

Status 

Bar 
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Entering Data in a Selected Range 

 

To speed data entry, one can preselect the range in which data is entered. Then, the active cell 

will move automatically to another cell in the range after a specified key is pressed.  

 

To enter data in selected range, select the range in which data is to be entered. The first cell in 

the selected range is active and appears with a white background; Type the data to be entered 

in the first cell; Press Enter to move down one cell, press Shift+Enter to move up one cell, 

press Tab to move right one cell, or press Shift+Tab to move left one cell.  

 

Entering Data Series 

 

Excel includes a feature named AutoFill, which enables the user to enter sequences of values 

automatically. AutoFill can be used for dates, months, years, positive and negative numbers, 

certain sequences such as Qtr 1, Qtr 2, and so on.  

 

To fill a range with a sequence of numbers, enter the numbers in the first two cells of the 

range. (These two cells can be in the same column or the same row.) ; Select the two cells, 

then position the mouse pointer over the handle in the lower-right corner of the selected 

range; the pointer changes to a cross; Drag the cross to the end of the range to be filled with 

the sequence and release the mouse button; AutoFill completes the sequence of numbers.  

 

Entering Dates and Times 

 

To quickly enter the current date in a cell, select the cell and press Ctrl+; (semicolon). To 

enter the current time in a cell, press Ctrl+: (colon). The date and time can be combined in a 

single cell by separating the date and time with a space.  

 

To manually enter a date or time, enter the date into the cell using any of these formats: 

11/6/97, 6-Nov-97, 6-Nov, Nov-97; or, enter the time into the cell using any of these formats: 

21:41, 21:41:35, 9:41 PM, 9:41:35 PM. For any other styles, Excel will format the number 

using one of the formats listed above. If Excel does not recognize the entry as a valid date or 

time format, the entry is treated as text and, in an unformatted cell, aligns it to the left.  

 

Selecting Multiple Ranges/Worksheets 

 

While working in Excel, more than one range of data can also be selected. Instead of selecting 

ranges individually and formatting them, all ranges can be formatted at once.  

 

To select multiple ranges, select the first range of cells; Hold down the Ctrl key; then click 

and drag to select the next range of cells; Repeat Step 2 until all the desired ranges are 

selected.  

 

Complete Worksheet(s) can also be selected, if the user wants to group the worksheets and 

perform actions on all selected worksheets.  

 

To select a worksheet in the current workbook, click the sheet tab. The worksheet displays; If 

all cells are to be selected in the current worksheet, click the rectangle that appears at top left 
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corner, at the intersection of the row headers and column headers; To select multiple 

Worksheets, hold down the Ctrl key; then repeat the above steps.  

 

Hiding Gridlines/ Row and Column Headings 

 

The user can hide the worksheet gridlines (and other screen elements) to make the display 

appear less like a spreadsheet and more like a graphic or paper display. Hiding the on-screen 

gridlines also gives a better appearance to data-entry forms and on-screen reports. 

 

To turn the worksheet gridlines off, choose Page Layout, clear the Gridlines check box.  

 

There are other parts of the Excel worksheet that can be hidden from view. These options 

appear on the Page Layout tab. 

 

Hiding Worksheets/Workbooks 

 

The user may want to hide a worksheet in a shared workbook so that others will not see the 

worksheet.  

 

To hide a Worksheet, right click the on sheet tab for the worksheet to be hidden; Choose 

Hide. To restore the worksheet, right click the on any sheet tab, choose Unhide. In the Unhide 

dialog box, select the name of the worksheet to be displayed; then click OK.  

 

To hide a Workbook, the mouse pointer in the workbook to be hidden, choose View, Hide. To 

restore the workbook, choose View, Unhide. In the Unhide dialog box, select the name of the 

workbook to be displayed; then click OK.  

 

Hiding Columns and Rows 

 

The user can hide columns/rows temporarily so that they do not print or appear on-screen. 

Hiding columns or rows doesn't affect the results of formulas that refer to hidden cells. To 

hide column/row, right-click the column heading of the column to be hidden, or right-click 

the row heading of the row to be hidden; from the shortcut menu, choose Hide. 

 

Windows Freezing Worksheet Panes 

 

Excel enables the user to freeze the window pane at selected rows and columns so that they 

remain on-screen as he scrolls through large worksheets. To freeze Worksheet panes, position 

the cell pointer at the intersection of the row and column that is to be remained on-screen 

while moving through the worksheet; Choose View, Freeze Panes. To unfreeze the window 

pane, choose View, Freeze Panes, Unfreeze Panes.  

 

Inserting and Deleting Columns/Rows 

 

As the user edits worksheet, he may need to insert or delete entire columns/rows in the 

worksheet. If a column/row is to be inserted, select the column/row header of the column/row 

to be move to the right when the new column/row is inserted; or, if deleting a column/row, 

select the column/row header of the column/row to be deleted; To insert a column, on the 
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Home tab, choose Insert, Insert Sheet Columns/Insert Sheet Rows; or, to delete the selected 

column/row, choose Delete.  

 

Inserting Worksheets 

 

New worksheets can be easily inserted (as many as 255 total) at any time. To insert a 

Worksheet, open the workbook to which a new worksheet is to be added; Choose Insert, 

Sheet. The new worksheet is inserted just before the current worksheet; Drag the sheet tab of 

the new worksheet to where the worksheet is to be appeared.  

 

The default number of worksheets that appears in a new workbook can also be changed. 

Choose File, Options; then click the General tab. In the Include this many sheets text box, 

type the number of worksheets to be contained in new workbooks; then click OK.  

 

Naming Worksheets 

 

The user can also assign his descriptive name of up to 31 characters to each worksheet. The 

characters / \ : ? * [ ] < > cannot be used in the names. To name a Worksheet, double-click the 

sheet tab for the worksheet to be renamed; Type the new name for the worksheet and press 

Enter.  

 

Rotating Text 

 

In Excel, the default orientation for text is horizontal, reading left to right. Text can also be 

rotated to any direction. This can be used for vertical titles for reports or to label the sides of 

charts, tables, or drawings.  

 

To rotate text, select the cell or range containing data to be rotated. Choose Format, Cells; 

then click the Alignment tab; In the Orientation area, drag the pointer in the second box up or 

down to change the orientation of the text (as displayed in the Orientation preview box); or, 

specify a value in the Degrees box between 90 and -90 degrees. Then click OK. Or, select the 

cell or range containing data to be rotated. In the Home tab, Alignment portion, choose the 

Orientation button. Select the desired option.  

 

Shrinking Text to fit in a Cell 

 

If the user needs to fit text in a cell without widening the column containing the text, he can 

shrink the size of the text by using the Shrink to Fit alignment option.  

 

Select the cell or range containing data to be shrunk and right click on it. Choose Format, then 

click the Alignment tab; Select the Shrink to Fit option; then click OK.  

 

Wrapping Text in a Cell 

 

For long text entry in a cell, Excel can wrap the text so that it forms a paragraph that fits 

inside that cell by increasing cell's height to accommodate multiple lines of text. Select the 

cell or range containing data to be wrapped. Choose Format, then click the Alignment tab; 

Select the Wrap Text option; then click OK.  
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Charts/Graphs 

 

Microsoft Excel no longer provides the chart wizard. Instead, you can create a basic chart by 

clicking the chart type that you want on the Insert tab in the Charts group. To create a chart 

that displays the details that you want, you can then continue with the next steps of the 

following step-by-step process. A chart has many elements. Some of these elements are 

displayed by default, others can be added as needed. You can change the display of the chart 

elements by moving them to other locations in the chart, resizing them, or by changing the 

format. You can also remove chart elements that you do not want to display. Instead of 

manually adding or changing chart elements or formatting the chart, you can quickly apply a 

predefined chart layout and chart style to your chart. 

 

Conditional Formatting 
 

By applying conditional formatting to your data, you can quickly identify variances in a range 

of values with a quick glance. 

 

To apply conditional Formatting go to the Home tab, in the Styles group, click the arrow next 

to Conditional Formatting, and then click Color Scales. Hover over the color scale icons to 

see a preview of the data with conditional formatting applied. In a three-color scale, the top 

color represents higher values, the middle color represents the medium values, and the bottom 

color represents the lower values. 

 

Now experiment with the conditional formatting’s available styles. After you have applied a 

style, select your data, click Conditional formatting on the ribbon, and then click manage rules 

to manually fine tune your rules and formatting. 

 

EXERCISE 

 

Design a fruit name puzzle as given below. It has four fruit names. Mango, Apple, Pineapple, 

and Orange. 

    M     

P I N E A P P L E 

    N     

O R A N G E    

    O     

 

For a user the puzzle will be blank. Enter Hints for solving the Puzzle. A box will contain the 

text “Keep Trying” if the puzzle is unsolved or incorrectly solved. If the user solve puzzle 

correctly then this box contains “WELL DONE !!!”. If the user enters correct alphabet it 

should be highlighted as BLUE. If the user enters wrong alphabet it should be highlighted as 

RED. Format your work accordingly. 

 

Hint: Use Conditional Formatting. 

 

Attach the colored printout here. 

WELL DONE !!! 
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Lab Session 07 
 

OBJECT 
 

Working with formulas and functions in Microsoft Excel 
 

 

Entering Formulas 

 

Formulas enable the user to perform calculations by using values in the worksheet. Arithmetic 

operators that can be used in formulas include + for addition, - for subtraction, * for 

multiplication, / for division, % for percentage, and ^ for exponentiation. For example: 

=a1+b1     adds the contents of a1 and b1 in the cell where the formula is typed. 

 

To fill the same formula in multiple cells, select the adjacent cells or ranges to be filled; With 

the range(s) still selected, type the formula or value in the active cell; Press Ctrl+Enter (rather 

than just Enter) to enter the formula or value.  

 

To reference cells in other Worksheets, select the cell where the formula is to be appeared , 

and type an equal sign (=) to start the formula; Click the sheet tab containing the cell to be 

referenced in the formula; Select the cell or range to be referred to. The complete reference 

appears in the formula bar; Finish the rest of the formula; then press Enter to complete the 

formula.  

 

Excel also provides functions like SUM, AVERAGE, etc. Select the cell where the function is 

to be appeared, and type an equal sign (=) to start the function; Type the function name (such 

as SUM, AVERAGE, etc) and a left parenthesis; Select the range of cells for the argument 

and press Enter. Excel automatically adds the closing parenthesis and enters the function. 

References to columns or rows can also be entered manually, using comas (,) for separation. 

If colon (:) is used between two references then, it acts as range operator, which produces one 

reference to all the cells between two references, including the two reference. Following are 

some of the most commonly used formula. 

 

- SUM: Adds all the numbers in a range of cells. 

Syntax: =SUM(number1, number2, …..) 

  

- AVERAGE: Returns the average (arithmetic mean) of the arguments. 

 Syntax: =AVERAGE(number1, number2, …..) 

 

- COUNT: Counts the number of cells that contain numbers and numbers within the list of 

arguments. 

 Syntax: =COUNT(value1, value2, …..) 

 

- COUNTA: Counts the number of cells that are not empty and the values within the list of 

arguments. 

 Syntax: =COUNTA(value1, value2, …..) 

 

- PRODUCT: Multiplies all the numbers given as arguments and returns the product. 
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Syntax: =PRODUCT (number1, number2, …..) 

 

- SUMIF: Adds the cells specified by a given criteria. 

Syntax: SUMIF (range, criteria, sum_range) 

Where ‘Range’ is the range of cells to be evaluated according to the given criteria. 

‘Criteria’ is the criteria in the form of a number, expression, or text that defines which 

cells will be added. ‘Sum_range’ are the actual cells to sum. The cells in sum_range are 

summed only if their corresponding cells in range match the criteria. If sum_range                                           

is omitted, the cells in range are summed. 

 

For example: Suppose B1:B4 contain the values 100, 200, 300, and 400 respectively. 

C1:C4 contains 1, 4, 6, and 2 respectively. Now the expression SUMIF (B1:B4,">275", 

C1:C4) will add 6 and 2 as there corresponding values in cells B3 and B4 are greater than 

275. Hence the result will be 8. If sum_range argument is omitted then the result becomes 

700. 

 

- FACT: gives factorial of a number 

Syntax: FACT (num) 

 

- Large: returns kth largest value 

Syntax: Large (Array, K) 

 

- SMALL: returns kth smallest value 

Syntax: small (array, k) 

 

- Ceiling: returns nearest kth value integer 

 

Formulas: Absolute, Relative, and Mixed Cell References 

 

When a cell contains a formula with references to other cells, several methods can be used to 

handle those references.   

 

Excel normally uses relative references for cell addresses in a formula, unless specified 

otherwise. When relative references are used, the cell references in a formula automatically 

adjust after the formula is copied to another cell or range. If cell B10 contains the formula 

=SUM(B3:B9), for example, and user copies this formula from cell B10 to cell C10, the new 

formula in cell C10 automatically adjusts to read =SUM(C3:C9). 

 

To prevent a cell reference in a formula from changing when that formula is copied to another 

cell or range, use an absolute reference. Absolute references can be indicated by typing a 

dollar sign ($) in front of the column letter and the row number. In a sales worksheet, for 

example, if the user have a column of formulas that multiply a value by the commission 

percentage located in cell D7, he could use $D$7 to refer to that percentage in the first cell; 

then copy the formula down the column. 

 

Combinations of these two types of references called mixed references can also be used. For 

example $C3 prevents the column from changing, C$3 adjusts the column to a new location 

but the row remains fixed when the formula is copied. 
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To use this, place the cell pointer in the cell where the formula is to be entered; To enter an 

absolute or mixed reference in a formula, type an equal sign (=) to start the formula (to enter a 

relative reference, just type the reference--no special treatment is needed). Then type or click 

the cell reference; Press F4 until the desired combination of dollar signs appears, and then 

type the arithmetic operator, such as a plus sign (+); Continue to type other values or cell 

references and operators as needed; then press Enter to complete the formula.  

 

Creating a Text String 

 

At times, the user may need to create a formula that joins the contents of two cells. Excel 

refers to this action as concatenation.  

 

For example: If a worksheet includes first names in column B3 and last names in column C3, 

the user can enter a formula in a third column that joins the first name with the last name: 

=B3&" "&C3     where ampersand (&) is the concatenation operator and (" ") simply indicates 

a space between the two text strings.   

 

Displaying Formula Instead of Results 

 

From anywhere in the worksheet, choose Formulas, click the Show Formulas button.  

To display the results again, choose Formulas, click the Show Formulas button again. Press 

Ctrl+ ' (the grave accent, usually located on the same key as the tilde character) to toggle 

between viewing results and formulas. 

 

 

Auto Calculate 

 

Select the range to be summed. The Calculate button in the status bar automatically displays 

the sum of the selected range (or right click the Auto Calculate button to see more functions); 

Right-click the Auto Calculate button in the status bar; From the pop-up menu that appears, 

select the function to be used, such as Average or Count. The result of the function selected 

appears in the status bar.  

 

Logical Functions 

 

The logical functions enable the user to add decision-making and logical tests to the 

worksheets. The IF statement is useful for testing conditions and making decisions based on a 

cell's contents. The AND and OR functions can test multiple criteria or test conditions for use 

in IF functions. The following examples show the use: 

• =AND(D15,G23<30)     result is TRUE only when D15 is not zero and G23 is less than 

30 

• =IF(AND(D17>10,D17<30),"Valid","Invalid")     returns Valid if the contents of 

cell D17 is greater than 10 and less than 30; otherwise the formula returns Invalid 

• =IF(NOT(OR(D17=10,D17=30)),"Not 10 or 30","Contains 10 or 30")     tests 

whether cell D17 contains the result 10 or 30 and produces the message Not 10 or 30 

when the cell does not contain either of those results; otherwise, the formula result is 
Contains 10 or 30 
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• =IF(OR(D17=10,D17=30),"Contains 10 or 30","Not 10 or 30")     tests whether 

cell D17 contains the result 10 or 30 and produces the message Contains 10 or 30 

when it does; otherwise, the formula produces the message Not 10 or 30 

 

Math and Trigonometric Functions 

 

Like logical functions, math and trigonometric functions can also be used in the Worksheets. 

Trigonometric functions use angles measured in radians.  

Following are some examples: 

• =ABS(A10)     returns 18 when cell A10 contains -18 

• =ACOS(0.5)     returns 1.047198 (radians) 

• =DEGREES(0.5)      returns 28.64789 (degrees)  

• =LOG(12,3)      returns 2.26186 

• =ROUND(102.927,2)     returns 102.93 

 

Statistical Functions 

 

Similarly, statistical functions can als0 be used in the Worksheets. For example: 

• =COUNTIF(B1:B4,">100")     returns 1 if the range B1:B4 contains the numbers 57, 102, 84, 

and 98 

• =MEDIAN(1,4,2,6,9)     returns 4 

• =MEDIAN(1,4,2,6,9,10)     returns 5 (average of the two middle values, 4 and 6) 

 

Print Titles 
 

Page layout →Print titles → Rows to repeat at top → $1:$n 

 

EXERCISES 

 

1. Design a TEMPERATURE CONVERTER from Celsius to Fahrenheit and Fahrenheit to 

Celsius. Present the Converter with appropriate design. Formulas for conversion are as 

follows: 
[°C] = ([°F] − 32) · 5/9 

[°F] = [°C] · 9/5 + 32 

Also report the weather conditions as HOT if the temperature exceeds 35°C, WARM if the 

temperature is between 20°C to 35°C and COLD if the entered temperature is below 20°C. 

 

1. Create a magic square puzzle as per given example below, the sum of all the numbers in a row 

must be equal, simultaneously the sum of all the numbers in a column must be equal, and the 

sum of diagonal numbers should also be equal: 

 

  12 3 9  24 

  5 8 11  24 

  7 13 4  24 

       

24  24 24 24  24 

 

WELL DONE!!! 
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Take the input from the user in all the squares. For a user all the squares will be blank initially 

and the box given below will contain the text “KEEP TRYING” unless the user enters all 

correct entries. If user solves the puzzle correctly then a message “WELL DONE” appears 

below. Format your work accordingly. 

 

 

Attach the printed output. 
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Lab Session 08 
 

OBJECT 
 

Familiarization with the environment of Microsoft Power Point 

 

USING POWER POINT 
 

A user can communicate information better and more easily with a PowerPoint presentation. 

A presentation is a series of slides that a user creates by using PowerPoint. The more 

important the message, the clearer the presentation should be. Also for larger audience, the 

message must be easy to grasp.  

 

The facilities PowerPoint provides are discussed below: 

 

Creating a New Power Point Presentation 
 

Presentation Type: Open Power Point and you will be prompted by a dialog box with 

different choices. These choices are explained below. If Power Point is already open or this 

box does not appear, select File|New from the menu bar. 

• Blank Presentation: Select Blank Presentation to build the presentation from scratch with 

no preset graphics or formatting. 

• Recent Templates: This option shows all the templates used previously during the current 

session of your work. 

• Sample Templates: This option provides templates and ideas for a variety of presentation 

types. Page through the wizard to select the required type. 

• Themes: Power Point provides many templates with different backgrounds and text 

formatting to begin your presentation. Preview each design by highlighting the template 

name in the menu. Double click on the chosen design to open the required template. 

• My Template: This option allows you to insert and/or create your own design template.  

• New from Existing: This option lets you convert the older version power point files into 

the current version. Then you can save it with the new format by using the File|Save 

option from the menu bar. 

To open an existing Power Point presentation, select File|Open option from the menu bar. 

Select the folder in which the file is located from the Look in: drop-down menu and highlight 

the file on the list. Click Open to open the presentation. 
 

Screen Layout Views 
 

Power Point gives you three screen layouts for constructing or viewing your presentation. 

These can be selected by using the icons given in the bottom right corner, or you can go to 

the View menu and select these options from the Presentation View section. 
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• Normal View: This screen is split into three sections showing the presentation window on 

the left, the slide in the main window, and notes at the bottom. The presentation window 

can further be viewed in two different ways: 

o Outline View: The presentation outline is displayed on the majority of the screen 

with small windows for the slide and notes. This view is recommended for editing 

text. 

o Slide View: The slide view displays each slide on the screen and is helpful for 

adding images, formatting text, and adding background styles. 

• Slide Sorter View: A small image of each slide is displayed in Slide Sorter view. Slides 

can easily be ordered and sorted from this screen. 

 
 
 

 

 

Click the Slide Show button to view the full-screen slide show. 

 

Working with Slides 
 

Insert a New Slide :In the Normal View, select the slide you want the new slide to appear 

after by clicking the slide's number. Select Home|NewSlide from the menu bar. Choose the 

page layout from the window.  
 

normal 

Figure 8.1: Screen Views 

Figure 8.2: The Power Point screen layout in Normal View 

slide show 

slide sorter 

menu bar 

presentation 
window 

slide window 

notes window 

screen views 

status bar 
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Applying a Design Template: To add a design template or change the existing one, select 

Design menu, and choose the template from the given options in the Themes section. If you 

want to change the design of only one slide, then right click on the chosen theme and select 

‘Apply to Selected Slide’ option. 
 

Changing Slide Layouts: To change the layout template of the slide, select 

Home|Layoutfrom the menu bar. Select one of the layout thumbnail images. 
 

Reordering Slides: To reorder a slide in Slide Sorter View, simply click on the slide you 

wish to move and drag it to the new location. In Normal or Outline View, click the slide icon 

beside the number of the slide you want to move and drag the icon to a new location. 
 

Hide Slides: If you do not want a slide to appear during the slide show, but do not want to 

delete the slide as it may be used later, the slide can be hidden by selecting 

SlideShow|HideSlide from the menu bar. To add the slide back to the slide show, select 

SlideShow|HideSlide again. 
 

Create a Custom Slide Show: The Custom Slide Show feature allows you to select the slides 

you want to display in the slide show if not all the slides should be used. For this, select Slide 

Show|Custom Slide Show|Custom Shows menu bar; Click the New... button in the Custom 

Shows window; In the Define Custom Show window, type a name for the slide in the Slide 

show name field; Add slides to the custom show by highlighting them in the Slides in 

presentation window and clicking the Add>> button. Those slides will then appear in the 

Slides in custom show window; To remove slides from the custom show, highlight their 

names in the Slides in custom show window and click the Remove button; To reorder slides in 

the custom show, highlight the slide that should be moved and click the up and down arrows 

to change its order in the show; Click OK when finished; Click the Show button on the 

Custom Shows window to preview the custom slide show and click Close to exit.  
 

Edit a Custom Slide Show: Select Slide Show|Custom Slide Show|Custom Shows from the 

menu bar and then choose the custom show that needs to be edited from the window that 

appears on screen. To edit, click on the Edit... button; to delete a show, highlight the name 

and click Remove; to create a copy of a show, click the Copy button. The copy can then be 

renamed by clicking the Edit... button; Click the Show button to preview the custom slide 

show and click Close to exit.  

 

Adding Contents 
 

Bulleted Lists on Design Templates: Bulleted lists allow you to clearly display the main 

points of your presentation on slides. The text boxes on design templates already include 

bulleted lists. Click the place holder on the slide to begin adding text and press the ENTER 

key to return to the next line and add a new bulleted item. To go to the next line without 

adding another bullet, hold down the SHIFT key while pressing ENTER.  
 

Additional Bulleted List: In slide view, create a text box by selecting Insert|Text Box from 

the menu bar. Then draw the text box on the slide by holding down the left mouse button 

while you move the mouse until the box is the size you want it. Select the Bullets icon from 

the Home menu to insert new bullets in the text box. In order to change the formatting of 

bullets, click on the arrow besides the Bullets icon and select the Bullets and Numbering… 
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option. This opens a new window, from where you can change the size and color of the 

bullets. You can also click the Picture button to view the Picture Bullet window. Select one 

of the bullets and click OK. 

-OR- 

Click the Customize button to select any character from the fonts on the computer. Select a 

symbol font such as Wingdings or Webdings from the Bullets from drop-down menu for the 

best selection of icons. Click on the characters in the grid to see them larger. Click OK when 

you have chosen the bullet you want to use. Click OK on the Bullets and Numbering window 

and use the same methods described in the "Bulleted Lists on Design Templates" to enter text 

into the bulleted list. 
 

Bulleted Lists and New Slides from an Outline: In Normal or Outline view, text can easily 

be entered in the outline window and new slides are automatically added. Next to the Slide 1 

icon, type the title of the slide. The text you type beside the slide icons will be the large-type 

titles on each slide. Press ENTER to type the next line. This will automatically create a new 

slide. To create a bulleted list for the first slide, press the TAB key or click the demote button 

on the More Buttons menu accessible by clicking the "triple arrow" button at the end of the 

formatting toolbar . 

-OR- 

Press ALT+SHIFT+Right Arrow to demote the selection to a bulleted list item; Continue 

entering text for the bulleted list, pressing ENTER at the end of each line to create a new 

bullet; Create a multilevel list by executing the demote action again to create a bulleted sub 

list. Press the promote button on the More Buttons menu or press ALT+SHIFT+Left Arrow 

to return to the original list; Create a new slide by executing the promote action until a new 

slide icon appears; Continue creating new slides and bulleted lists by using the demote and 

promote actions until the presentation is completed. Use the formatting instructions below to 

format the lists. 

If there is more than one bulleted list on the slide, the lists will be designated by numbers 

enclosed in black boxes. The example below shows the slide created from the outline on the 

left. The bulleted list on the left side of the slide is labeled list "1" on the outline and the list 

on the right is labeled list "2". When typing the outline, begin typing in the new list by 

pressing CTRL+ENTER. In this example, CTRL+ENTER was pressed after typing "Access". 

 
 

Adding Notes: From Normal View, notes can be added to the slide. These notes will not be 

seen on your presentation, but they can be printed out on paper along with the slide. This can 

be done by selecting File/Print menu, then under the Settings, in the second drop down 

menu, select the option ‘Notes Pages’. 

Figure 8.3 
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Video: To add a video to your presentation select Insert|Video|Video from File or to insert a 

video from Microsoft's gallery choose Insert|Video|Clip Art Video. Select the video file and 

click OK. 
 

Audio: To add sound to your presentation, select Insert|Audio|Audio from File or Clip Art 

Audio. Select a sound file and click OK. 

 

Graphics 
 

The Drawing Toolbar provides many commands for creating and editing graphics. Select 

Insert menu to choose the different tools as explained below: 

 

Adding Clip Art: Select Insert|Clip Art from the menu bar, and use various options to insert, 

preview and edit the clips. 
 

Adding Picture or Photo Album: To add a photo or graphic from a file, select Insert|Picture 

from the menu bar. Choose the file and insert it. Similarly, in order to insert a complete 

interactive photo album to the slide, select Insert|Photo Album option. 
 

Adding Shapes: The Shapes menu allows you to add a number of geometrical shapes, 

arrows, flow chart elements, stars, and other graphics on a slide. Select Insert|Shapes from 

the menu bar, and choose one of the different shapes provided in the drop down menu.  
 

Adding Action Buttons: Use the action button toolbar to add functioning buttons to slides in 

a presentation. Select Insert|Shape from the menu bar and choose the Action Buttons given in 

the menu. As soon as the button is placed on the slide, the Action Settings window will 

appear on screen. Set the actions under either the Mouse Click or Mouse Over tabs. Actions 

specified for Mouse Click will execute when the button is clicked on the slide while actions 

for Mouse Over will occur when the mouse pointer hovers over the button. Select an action 

for the button by choosing a Hyperlink to destination. If you want a sound to be played when 

the button is clicked, check the Play sound box and choose a sound from the drop-down 

menu. Click OK when finished. If the window does not appear, first click on the action 

button to select it. Then select Insert|Actions option to open the Action Settings window. The 

button on the slide can be resized using the white box handles and the depth of the button can 

be changed by dragging the yellow diamond. 
 

Adding WordArt:Add headlines in striking colors and shapes to your presentation using 

Word Art.Select Insert|WordArt from the menu bar to choose a Word Art style from the 

listing. 

 

Adding Charts: A graph or a chart can be used in a presentation to highlight its activity. 

Select Insert|Chart from the menu bar. A window appears with different types of charts 

available in the software. Select any one, and click OK. A spreadsheet opens up, which lets 

you edit the values and range of the chart as per user requirement. 

 

Adding SmartArt: SmartArt Graphics include different types of lists, cycles, hierarchies, 

relationships, etc. that may be useful in a technical presentation. Select Insert|SmartArt from 

the menu bar, and then choose the required options from the window. 
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Slide Animation: Several animations for slide objects are available through Animation menu 

on the menu bar. First, select the text box or graphic that will be animated. Select one of the 

options from the ‘Animations’ section. To select a different animation or turn the animation 

off, select the appropriate choice from the same menu. You can also change the duration of 

your animation by specifying the number of seconds in the ‘Duration’ box. The ‘Delay’ 

option can be used to delay or stop your animation from appearing for the specified number 

of seconds.  
 

Slide Transitions: Select Transition tab from the menu bar. From the ‘Transition to This 

Slide’ section, choose a transition and notice the preview after the transition is selected. The 

speed or duration of transition can be changed by entering the time value in the ‘Duration’ 

box. You can check the "On mouse click" checkbox for the slide transition to occur by 

clicking the mouse or using keystrokes, or check the "After:" checkbox and a number of 

seconds if the transition should occur automatically. Select a Sound if necessary and check 

the Loop until next sound if it should keep repeating until the next sound is played. Click 

Apply to All if the transition effects should be added to every slide or Apply if the effects 

should be added only to the current slide.  

 

Presentation Basics 
 

▪ Begin the slide show by clicking the Slide Show button on the bottom of the screen.  

▪ Move to the next slide by pressing the SPACE BAR, ENTER, PAGE DOWN, or right arrow 

keys or by clicking the left mouse button. 

▪ Go back to the previous slide by pressing BACKSPACE, PAGE UP, or the left arrow key. 

▪ To end the slideshow before it is complete press ESC on the keyboard. 

▪ A pen tool is available for drawing on the screen with the mouse. Press CTRL+P or click 

the right mouse button at any time and a popup window will appear. Choose Penand the 

pointer will change to a pen that allows you to draw freehand on the screen using the 

mouse. Press the E key to erase all pen strokes. Press CTRL+A to disable the pen feature 

and revert the pen back to a pointer arrow. 

▪ If you would like to use the pen to draw on a blank screen during a presentation, press the 

B or W keys, or select Screen/Black Screen from the popup menu and the screen will turn 

black. Press B or W again or choose Next from the popup menu to return to the presentation 

when you are finished drawing. 

▪ To hide the pointer and button from the screen press the A key. 

▪ Be sure to preview the slide show using a projector if one will be used during the 

presentation. Words or graphics that are close to the edge of the screen may be cut off by 

the projector. 

 

EXERCISES 
 

• Create a Power Point presentation on a topic of your own choice of 6 slides. Add 

appropriate animation effects and clip arts, smart art, graphs, photos videos, etc to make a 

powerful presentation. 

 

Attach the colored printout here. 
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Lab Session 09 
 

OBJECT 
 

Creating databases using Microsoft Access 

 

USING MICROSOFT ACCESS 
 

FAMILIARIZATION WITH SOME BASIC DATABASE RELATED TERMS 
 

• A record in a row on a datasheet and is a set of values defined by fields. In a mailing 

list table, each record would contain the data for one person as specified by the 

intersecting fields. 

• A field is a column on a datasheet and defines a data type for a set of values in a table. 

For a mailing list table might include fields for first name, last name, address, city, 

state, zip code, and telephone number. 

• A table is a grouping of related data organized in fields (columns) and records (rows) 

on a datasheet. By using a common field in two tables, the data can be combined. Many 

tables can be stored in a single database.  

• A database is a collection of related information. 
 

 
Figure 9.1 MS Access Welcome window 
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GETTING STARTED 
 

After opening Access, you will be presented with two major options as shown in figure 

above. First if you are creating a new database or the second if you want to open and edit 

an existing database. Details about both of these choices are given below:  
 

Open an existing database 

 

If the database was opened recently on the computer, it will be listed in the File Menu 

either directly or inside Recent option. Highlight the database name and click OK. 

Otherwise, click Open (Ctrl + O) from File Menu, navigate to proper folder location, 

highlight the database name in the listing and click OK. 

 

Creating a new database 
 

Click New (Ctrl + N) option inside the File Menu. You will be presented with MS Access 

available database templates both offline and online and then you are required to select any 

one of them to create your new database. Some of the example offline database templates 

include Blank Database, Blank Web database, sample database etc. Some of the example 

online database templates include Assets, Contacts, Issues and Tasks etc. Unlike Word 

documents, Excel worksheets, and Power Point presentations, you must save an Access 

database before you start working on it. After selecting "Blank Access database" for 

example, you will first be prompted to specify a location and name for the database. 

 

SCREEN LAYOUTS 
 

Database Window 
 

The Database Window (figure 9.2) organizes all of the objects in the database e.g. Tables, 

Queries, Forms etc. The default table listing provides links for creating or modifying tables 

and will list all of the tables in the database when they have been added. 

 

Design View 
 

Design View (Figure 9.3) customizes the fields in the database so that data can be entered. 

 

Datasheet View 
 

The datasheet view (Figure 9.4) allows you to enter data into the database. 
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Figure 9.2: Database Window 

 

 
Figure 9.3: Design View 
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Figure 9.4: Datasheet View 

CREATING TABLES 
 

Introduction to Tables 
 

Tables are grids that store information in a database similar to the way an Excel worksheet 

stores information in a workbook. To create a table Click Create from Main Menu. Access 

provides two ways to create a table for which there are icons Table and Table design. 

Double-click on any icon to create a table. 

• Create table in Design view will allow you to create the fields of the table. This is the 

most common way of creating a table and is explained in detail below.  

• Create table by entering data will give you a blank datasheet with just ID field and the 

rest with unlabeled columns that looks much like an Excel worksheet. Enter data into 

the cells and click the Save button. After the table is saved, the empty cells of the 

datasheet are trimmed. The fields are given generic names such as "Field1", "Field2", 

etc. To rename them with more descriptive titles that reflect the content of the fields, 

change the view to Design view again and modify names as per requirements.  
 

Create a Table in Design View 
 

Design View will allow you to define the fields in the table before adding any data to the 

datasheet. The window is divided into two parts: a top pane for entering the field name, 

data type, and an option description of the field, and a bottom pane for specifying field 

properties as shown in (figure 9.3) 
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• Field Name - This is the name of the field and should represent the contents of the field 

such as "Name", "Address", "Final Grade", etc. The name cannot exceed 64 characters 

in length and may include spaces.  

• Data Type is the type of value that will be entered into the fields. 

o Text - The default type, text type allows any combination of letters and numbers up 

to a maximum of 255 characters per field record. 

o Memo - A text type that stores up to 64,000 characters. 

o Number - Any number can be stored. 

o Date/Time - A date, time, or combination of both. 

o Currency - Monetary values that can be set up to automatically include a dollar sign 

($) and correct decimal and comma positions. 

o AutoNumber - When a new record is created, Access will automatically assign a 

unique integer to the record in this field. From the General options, select Increment 

if the numbers should be assigned in order or random if any random number should 

be chosen. Since every record in a datasheet must include at least one field that 

distinguishes it from all others, this is a useful data type to use if the existing data 

will not produce such values. 

o Yes/No - Use this option for True/False, Yes/No, On/Off, or other values that must 

be only one of two. 

o OLE Object - An OLE (Object Linking and Embedding) object is a sound, picture, 

or other object such as a Word document or Excel spreadsheet that is created in 

another program. Use this data type to embed an OLE object or link to the object in 

the database. 

o Hyperlink - A hyperlink will link to an Internet or Intranet site, or another location 

in the database. The data consists of up to four parts each separated by the pound 

sign (#): DisplayText#Address#SubAddress#ScreenTip. The Address is the only 

required part of the string. Examples: 

Internet hyperlink example: FGCU Home Page#http://www.fgcu.edu# 

Database link example: #c:\My Documents\database.mdb#MyTable 

• Description (optional) - Enter a brief description of what the contents of the field are.  

• Field Properties - Select any pertinent properties for the field from the bottom pane.  
 

Field Properties 
 

Properties for each field are set from the bottom pane of the Design View window. 

 

▪ Field Size is used to set the number of characters needed in a text or number field. The 

default field size for the text type is 50 characters. If the records in the field will only 

have two or three characters, you can change the size of the field to save disk space or 

prevent entry errors by limiting the number of characters allowed. Likewise, if the field 

will require more than 50 characters, enter a number up to 255. The field size is set in 

exact characters for Text type, but options are given for numbers:  

o Byte - Positive integers between 1 and 255  

o Integer - Positive and negative integers between -32,768 and 32,768  
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o Long Integer (default) - Larger positive and negative integers between -2 billion 

and 2 billion.  

o Single - Single-precision floating-point number  

o Double - Double-precision floating-point number  

o Decimal - Allows for Precision and Scale property control  
 

▪ Format confirms the data in the field to the same format when it is entered into the 

datasheet. For text and memo fields, this property has two parts that are separated by a 

semicolon. The first part of the property is used to apply to the field and the second 

applies to empty fields. 
 

Primary Key 
 

Every record in a table must have a primary key that differentiates it from every other 

record in the table. In some cases, it is only necessary to designate an existing field as the 

primary key if you are certain that every record in the table will have a different value for 

that particular field. A social security number is an example of a record whose values will 

only appear once in a database table. 

 

 
 

Figure 9.5 Quick Access Toolbar – Table Tools 

Designate the primary key field by right-clicking on the record and selection Primary Key 

from the shortcut menu or select Primary Key from the Quick Access Toolbar as given in 

figure above. The primary key field will be noted with a key image to the left. To remove a 

primary key, repeat one of these steps. 
 

Indexes 
 

Creating indexes allows Access to query and sort records faster. To set an indexed field, 

select a field that is commonly searched and change the Indexed property to Yes 

(Duplicates OK) if multiple entries of the same data value are allowed or Yes (No 

Duplicates) to prevent duplicates. 
 

Field Validation Rules 
 

Validation Rules specify requirements (change word) for the data entered in the worksheet. 

A customized message can be displayed to the user when data that violates the rule setting 

is entered. Click the expression builder ("...") button at the end of the Validation Rule box 

to write the validation rule. Examples of field validation rules include <> 0 to not allow 

zero values in the record, and ??? to only all data strings three characters in length. 
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Input Masks 
 

An input mask controls the value of a record and sets it in a specific format. They are 

similar to the Format property, but instead display the format on the datasheet before the 

data is entered. For example, a telephone number field can formatted with an input mask to 

accept ten digits that are automatically formatted as "(555) 123-4567". The blank field 

would look like (___) ___-____. Add an input mask to a field by following these steps: 

▪ In design view, place the cursor in the field that the input mask will be applied to.  

▪ Click in the white space following Input Mask under the General tab.  

▪ Click the "..." button to use the wizard or enter the mask, (@@@) @@@-@@@@, 

into the field provided.  
 

DATASHEET RECORDS 
 

Adding Records 
 

Add new records to the table in datasheet view by typing in the record beside the asterisk 

(*) that marks the new record. 
 

Editing Records 
 

To edit records, simply place the cursor in the record that is to be edited and make the 

necessary changes. Use the arrow keys to move through the record grid. The previous, 

next, first, and last record buttons at the bottom of the datasheet are helpful in maneuvering 

through the datasheet. 
 

Deleting Records 
 

Delete a record on a datasheet by placing the cursor in any field of the record row and 

select Delete Record from the menu bar or click the Delete button on the Quick Access 

toolbar. 
 

Adding and Deleting Columns 
 

Although it is best to add new fields (displayed as columns in the datasheet) in design view 

because more options are available, they can also be quickly added in datasheet view. 

Highlight the column that the new column should appear to the left of by clicking its label 

at the top of the datasheet and press right click then select Insert field from the dropdown 

menu. Entire columns can be deleted by placing the cursor in the column and selecting 

Delete field from the dropdown menu. 
 

Freezing and unfreezing Columns 
 

Similar to freezing panes in Excel, columns on an Access table can be frozen. This is 

helpful if the datasheet has many columns and relevant data would otherwise not appear on 

the screen at the same time. Freeze a column by placing the cursor in any record in the 

column and select Freeze fields from the right click dropdown men. Select the same option 

to unfreeze a single column or select Unfreeze All fields. 
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Finding Data in a Table 
 

Open the table in datasheet view. Place the cursor in any record in the field that you want to 

search and select Home|Find (Ctrl + F)... from the Quick Access toolbar. Enter the value 

criteria in the Find What: box. From the Look In: drop-down menu, define the area of the 

search by selecting the entire table or just the field in the table you placed your cursor in 

during step 2. Select the matching criteria from Match: to and click the More >> button for 

additional search parameters. When all of the search criteria are set, click the Find Next 

button. If more than one record meets the criteria, keep clicking Find Next until you reach 

the correct record.  
 

Table Relationships 
 

To prevent the duplication of information in a database by repeating fields in more than one 

table, table relationships can be established to link fields of tables together.  
 

Once you are in Design view or in datasheet view of a table, Table Tools Menu is 

automatically highlighted then click the Relationships button on the toolbar. . From the 

Show Table window (click the Show Table button on the toolbar to make it appear), double 

click on the names of the tables or queries you would like to include in the relationships. 

When you have finished adding tables or queries, click Close. To link fields in two 

different tables, click and drag a field from one table to the corresponding field on the other 

table and release the mouse button. The Edit Relationships window will appear. From this 

window, select different fields if necessary and select an option from Enforce Referential 

Integrity if necessary. These options give Access permission to automatically make 

changes to referential tables if key records in one of the tales is deleted or updated. Check 

the Enforce Referential Integrity box to ensure that the relationships are valid and that the 

data is not accidentally deleted when data is added, edited, or deleted. Click Create to 

create the link. A line now connects the two fields in the Relationships window. The 

datasheet of a relational table will provide expand and collapse indicators to view sub-

datasheets containing matching information from the other table.  
 

Sorting & Filtering 
 

Sorting and filtering allow you to view records in a table in a different way either by 

reordering all of the records in the table or view only those records in a table that meet 

certain criteria that you specify. 
 

Sorting  
 

In table datasheet view, place the cursor in the column that you want to sort by. Select 

Ascending or Descending from the Quick Access toolbar under Home main menu or click 

the Sort A to Z or Sort Z to A from the dropdown menu. 
 

To sort by more than one column (such as sorting by date and then sorting records with the 

same date alphabetically), highlight the columns by clicking and dragging the mouse over 

the field labels and select one of the sort methods stated above. 
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Filter by Selection  
 

This feature will filter records that contain identical data values in a given field such as 

filtering out all of the records that have the value "Smith" in a name field. To Filter by 

Selection, place the cursor in the field that you want to filter the other records by and click 

the Selection button inside Home main menu on the toolbar or directly select the criteria 

from right click dropdown menu.  
 

Filter by Form  
 

If the table is large, it may be difficult to find the record that contains the value you would 

like to filter by so using Filter by Form may be advantageous instead. This method creates 

a blank version of the table with drop-down menus for each field that each contains the 

values found in the records of that field.  
 

The following methods can be used to select records based on the record selected by that 

do not have exactly the same value. Type these formats into the field where the drop-down 

menu appears instead of selecting an absolute value. 
 

Saving A Filter 
 

The filtered contents of a table can be saved as a query by selecting Advanced|Save As 

Query. Enter a name for the query and click OK. The query is now saved within the 

database. 
 

Remove a Filter  
 

To view all records in a table again, click the depressed toggle Filter button. 
 

EXERCISES 
 

Create the following tables in Microsoft Access: 
 

Table1: Student (containing fields: Student ID, First Name, Last Name, Department and 

Class). 
 

Table2: Marks (containing fields: Student ID, ITC, Mathematics, English, Electronics, 

Physics). 
 

Select appropriate primary keys and define appropriate relationship for these two tables. 

Add some sample data to the tables and make a hard copy of the tables created. 

 

Attach your printout here. 
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Lab Session 10 
 

OBJECT 
 

Creating queries, forms and reports in Microsoft Access 

 

INTRODUCTION TO QUERIES 
 

Queries select records from one or more tables in a database so they can be viewed, 

analyzed, and sorted on a common datasheet. The resulting collection of records, called a 

dynaset (short for dynamic subset), is saved as a database object and can therefore be easily 

used in the future. The query will be updated whenever the original tables are updated. 

Types of queries are select queries that extract data from tables based on specified values, 

find duplicate queries that display records with duplicate values for one or more of the 

specified fields, and find unmatched queries display records from one table that do not have 

corresponding values in a second table. 
 

 
Figure 10.1 Create Menu Quick Access Toolbar 

 

Create a Query in Design View 
 

From the Create Main Menu as in figure 10.1, click the Query Design icon. Select tables 

and existing queries from the Tables and Queries tabs and click the Add button to add each 

one to the new query. Click Close when all of the tables and queries have been selected. 

Add fields from the tables to the new query by double-clicking the field name in the table 

boxes or selecting the field from the Field: and Table: drop-down menus on the query 

form. Specify sort orders if necessary. 
 

Enter the criteria for the query in the Criteria: field. The Expression Builder can also be 

used to assist in writing the expressions. After you have selected all of the fields and tables, 

click the Run button on the toolbar. Save the query by clicking the Save button.  
 

Query Wizard 
 

Click the Create query by using wizard icon in the database window to have Access step 

you through the process of creating a query. From the first window, select fields that will 

be included in the query by first selecting the table from the drop-down Tables/Queries 

menu. Select the fields by clicking the > button to move the field from the Available Fields 

list to Selected Fields. Click the double arrow button >> to move all of the fields to 

Selected Fields. Select another table or query to choose from more fields and repeat the 

process of moving them to the Selected Fields box. Click Next > when all of the fields have 

been selected. On the next window, enter the name for the query and click Finish.  
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Find Duplicates Query 
 

This query will filter out records in a single table that contain duplicate values in a field. 

Click the New button on the Queries database window, select Find Duplicates Query 

Wizard from the New Query window and click OK. Select the table or query that the find 

duplicates query will be applied to from the list provided and click Next >.  Select the 

fields that may contain duplicate values by highlighting the names in the Available fields 

list and clicking the > button to individually move the fields to the Duplicate-value fields 

list or >> to move all of the fields. Click Next > when all fields have been selected. Select 

the fields that should appear in the new query along with the fields selected on the previous 

screen and click Next >. Name the new query and click Finish. 
 

Delete a Query 
 

To delete a query, select the required query and press the Delete key on the keyboard. 
 

FORMS 
 

Forms are used as an alternative way to enter data into a database table. 
 

Create Form by Using Wizard 
 

From the Create Main Menu as in figure 10.1, click Form wizard option in Forms section. 

From the Tables/Queries drop-down menu, select the table or query whose datasheet the 

form will modify. Then, select the fields that will be included on the form by highlighting 

each one the Available Fields window and clicking the single right arrow button > to move 

the field to the Selected Fields window. To move all of the fields to Select Fields, click the 

double right arrow button >>. If you make a mistake and would like to remove a field or all 

of the fields from the Selected Fields window, click the left arrow < or left double arrow 

<< buttons. After the proper fields have been selected, click the Next > button to move on 

to the next screen. On the second screen, select the layout of the form. 
 

▪ Columnar - A single record is displayed at one time with labels and form fields listed 

side-by-side in columns. 

▪  Justified - A single record is displayed with labels and form fields are listed across the 

screen.  

▪ Tabular - Multiple records are listed on the page at a time with fields in columns and 

records in rows.  

▪ Datasheet - Multiple records are displayed in Datasheet View  
 

Click the Next > button to move on to the next screen. Select a visual style for the form 

from the next set of options and click Next >. On the final screen, name the form in the 

space provided. Select "Open the form to view or enter information" to open the form in 

Form View or "Modify the form's design" to open it in Design View. Click Finish to create 

the form. 
 

Adding Records Using A Form 
 

Input data into the table by filling out the fields of the form. Press the Tab key to move 

from field to field and create a new record by clicking Tab after the last field of the last 
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record. A new record can also be created at any time by clicking the New Record button 

at the bottom of the form window. Records are automatically saved as they are entered so 

no additional manual saving needs to be executed. 
 

Editing Forms 
 

The following points may be helpful when modifying forms in Design View: 
 

▪ Grid lines - By default, a series of lines and dots underlay the form in Design View so 

form elements can be easily aligned. To toggle this feature on and off right click and 

select Grid.  

▪ Resizing Objects - Form objects can be resized by clicking and dragging the handles on 

the edges and corners of the element with the mouse.  

▪ Change form object type - To easily change the type of form object without having to 

create a new one, right click on the object with the mouse and select Change To and 

select an available object type from the list.  

▪ Label/object alignment - Each form object and its corresponding label are bounded and 

will move together when either one is moved with the mouse. However, to change the 

position of the object and label in relation to each other (to move the label closer to a 

text box, for example), click and drag the large handle at the top, left corner of the 

object or label.  

▪ Tab order - Alter the tab order of the objects on the form by selecting Tab Order from 

design Menu when Form is active. Click the gray box before the row you would like to 

change in the tab order, drag it to a new location, and release the mouse button. 

▪ Form Appearance - Change the background color of the form by clicking the Shape 

Fill button on the format menu inside Form Design. Change the color of individual 

form objects by highlighting one and selecting a color from Color palette on the 

formatting toolbar. The font and size, font effect, font alignment, border around each 

object, the border width, and a special effect can also be modified using the formatting 

toolbar buttons inside Form Design Tools. 

  

Form Controls 
 

This section explains the uses for other types of form controls including lists, combo boxes, 

checkboxes, option groups, and command buttons. 

• List and Combo Boxes: If there are small, finite number of values for a certain field on 

a form, using combo or list boxes may be a quicker and easier way of entering data. 

These two control types differ in the number of values they display. List values are all 

displayed while the combo box values are not displayed until the arrow button is 

clicked to open.  
 

• Check Boxes and Option Buttons: Use check boxes and option buttons to display 

yes/no, true/false, or on/off values. Only one value from a group of option buttons can 

be selected while any or all values from a check box group can be chosen. Typically, 

these controls should be used when five or fewer options are available. Combo boxes or 

lists should be used for long lists of options.  
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• Command Buttons: Command buttons provide you with a way of performing action(s) 

by simply clicking them. When you choose the button, it not only carries out the 

appropriate action, it also looks as if it's being pushed in and released. 
 

Reports 
 

Reports will organize and group the information in a table or query and provide a way to 

print the data in a database. 
 

 

Using the Wizard 
 

From the Create Main Menu as in figure 10.1, click Report Wizard option in the Reports 

section. Select the information source for the report by selecting a table or query from the 

Tables/Queries drop-down menu. Then, select the fields that should be displayed in the 

report by transferring them from the Available Fields menu to the Selected Fields window 

using the single right arrow button > to move fields one at a time or the double arrow 

button >> to move all of the fields at once. Click the Next > button to move to the next 

screen.  
 

Select fields from the list that the records should be grouped by and click the right arrow 

button > to add those fields to the diagram. Use the Priority buttons to change the order of 

the grouped fields if more than one field is selected. Click Next > to continue. If the records 

should be sorted, identify a sort order here. Select the first field that records should be 

sorted by and click the A-Z sort button to choose from ascending or descending order. 

Click Next > to continue. Select a layout and page orientation for the report and click Next 

>. Select a color and graphics style for the report and click Next >. On the final screen, 

name the report and select to open it in either Print Preview or Design View mode. Click 

the Finish button to create the report. 
 

Create in Design View 
 

Click Report Design button in the Reports section of create access toolbar and you will be 

presented with a blank grid. Automatically properties window will open for this newly 

being created report. Click on Record Source property combo box and you will be 

presented with the list of available tables and queries. Choose the data source of the report 

from the drop-down menu and click OK. Design the report in much the same way you 

would create a form. For example, double-click the title bar of the Field Box to add all of 

the fields to the report at once. Then, use the handles on the elements to resize or move 

them to different locations, and modify the look of the report as per your requirements. 
 

EXERCISES 
 

1. For the tables created in laboratory session 08, create the following queries: 

• Select students’ marks in all the five courses with his/her first and last name. 

• Select the ID of those students who scored less than 40 marks in Mathematics. 

       Attach hard copies of the results of all the queries created. 

 

2. For the same data base, generate the following reports:  



Introduction to Computing                                                                Lab Session 10 
NED University of Engineering & Technology – Department of Computer & Information Systems Engineering 

 61 

• Report containing First Name, Last Name and marks in FCE. The report should be 

in descending order with respect to the marks in FCE. 

• Report for each student containing his/her complete personal information along 

with his/her marks for all the courses. 

       Attach hard copies of all the reports. 

 

Attach your printout here. 
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Section Three 
 

Computer Hardware 
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Lab Session 11 
 

OBJECT 
 

Experimenting with the AND, OR, NAND, NOR  and NOT integrated circuits. 

 

COMPONENTS REQUIRED 
 

• Bread board, 5 V - power supply, multimeter, logic probe (or LEDs with resistors), wires 

and the following ICs: 

• 7408 quad 2 input AND gate 

• 7432 quad 2 input OR gate 

• 7404 hex inverter 

• 7400 quad 2 input NAND gate 

• 7402 quad 2 input NOR gate 

 

THEORY 
 

Logic Gates 

 

Logic gates are the fundamental building blocks of digital systems. These devices are able to 

make decisions, in the sense that they produce one output level when some combinations of 

input levels are present and a different output when other combinations are applied; hence 

given the name Logic Gates. 

 

The two levels produced by digital circuitry are referred to variously as HIGH and LOW, 

TRUE and FALSE, ON and OFF, or simply 1 and 0. 

 

There are only three basic gates: AND, OR and NOT. The other gates are merely 

combinations of these basic gates. 

 

1. The AND Gate – An AND gate’s output is 1 if and only if all its inputs are 1. If A and B 

are two inputs to an AND gate then output, F of the gate is given as:  F = A.B 

 

2. The OR Gate - An OR gate’s output is 1 if at least one of its input is 1. If A and B are 

two inputs to an OR gate then output, F of the gate is given as:  F = A+B 

 

3. The NOT Gate (Inverter) – Its output is 1 when its input is 0 and its output is 0 when the 

input is 1; i.e. it complements a digital variable. If A is the input to a NOT gate then 

output, F of the gate is given as:  F = A 

 

4. The NAND Gate – Its output is 1 if at least one of its inputs is 0. This gate performs the       

same logic as an AND gate followed by an inverter. If A and B are two inputs to a NAND       

gate then output, F of the gate is given as:  F = A.B 
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5. The NOR Gate - The output of a NOR gate is 1 if and only if all its inputs are 0. This 

gate performs the same logic function as an OR gate followed by an inverter. If A and B 

are two inputs to a NAND gate then output, F of the gate is given as:    F = A+B 

 

All the above gates have one output and two or more inputs except the NOT gate, which has 

only one input. 

 

INTERNAL IC DIAGRAMS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 11.1 ICs Internal Diagrams 

 

 

7404 (Inverter IC) 

 

7408 (AND IC) 

 
7432 (OR IC) 

 

 
7402 (NOR IC) 

 

 
7400 (NAND IC) 
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PROCEDURE 

1. Set the power supply to 5V. With the help of a multimeter check the voltage at the output 

knobs of the power supply. 

2. Connect wires, long enough to reach the bread board, with the two knobs of the power 

supply. Again using multimeter, check the voltage at the non-connected end of the wires.  

3. Insert the 7408 quad 2 input AND gate IC on to the bread board and make supply and 

ground connections by joining 5V wire to pin # 14 and 0V wire to pin # 7. 

4. Consult IC’s internal connection diagram for input and output pins of the first AND gate. 

Connect input pins to logic 0 (0V) and observe the output using LED or logic probe.  

5. Try different combinations of logic levels at the two inputs. Again observe the output. 

6. Repeat the last two steps for all other gates of the same IC. Record the observations. 

7. Repeat this procedure for all other ICs.  

 

OBSERVATIONS 
 
AND Gate 

A B Expected Output Observed Output 

0 0   

0 1   

1 0   

1 1   

 

OR Gate 

A B Expected Output Observed Output 

0 0   

0 1   

1 0   

1 1   

 

NOT Gate 

A Expected Output Observed Output 

0   

1   
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NAND Gate 

 

A B Expected Output Observed Output 

0 0   

0 1   

1 0   

1 1   

 

 

 

 

 

NOR Gate 

 

A B Expected Output Observed Output 

0 0   

0 1   

1 0   

1 1   
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Lab Session 12 
 

 

OBJECT 
 

Finding expression for the given logic diagram, implementing the circuit on bread board, 

and observing output for various combinations of inputs. 

 

COMPONENTS REQUIRED 
 

• Bread board, 5 V - power supply, multimeter, logic probe (or LEDs with resistors), wires 

and the following ICs: 

• 7408 quad 2 input AND gate 

• 7432 quad 2 input OR gate 

• 7404 hex inverter 

• 7402 quad 2 input NOR gate 

 

LOGIC DIAGRAM 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 12.1 Logic Diagram 

 

THEORY 
 

Logic gates can be interconnected to perform a variety of logical operations. This 

interconnection of gates to achieve prescribed outcomes is called logic design. 

 

PROCEDURE 
 

8. Set the power supply to 5V. With the help of a multimeter check the voltage at the output 

knobs of the power supply. 

9. Connect wires, long enough to reach the bread board, with the two knobs of the power 

supply. Again using millimeter, check the voltage at the non-connected end of the wires.  

10. Insert ICs on the bread board and make their supply and ground connections. 

11. As given in the logic diagram, make connections using wires and gates in the ICs. 

12. Apply different combinations at the three inputs and observe the output. 

F 

A 

 

 

B 

 

 

C 

 

 
C 

C 
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OBSERVATIONS 
 

Logic expression for the given logic diagram: ______________________________________ 

 

The simplified Logic expression for the given logic diagram: __________________________ 

 

A B C Expected Output Observed Output 

0 0 0   

0 0 1   

0 1 0   

0 1 1   

1 0 0   

1 0 1   

1 1 0   

1 1 1   
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Lab Session 13 
OBJECT  
  

An Introduction to Electronics Workbench 

 

ELECTRONICS WORKBENCH - EWB 
 

Electronics Workbench is a computer aided design tool that provides you with all the 

components and instruments necessary to create board-level designs. It has complete 

mixed analog and digital simulation and graphical waveform analysis, allowing you to 

design your circuit and then analyze it using different simulated instruments and analysis 

options. It is fully integrated and interactive, thus you can change your circuits quickly, 

allowing fast and repeated what-if analysis.  

 

Electronics Workbench provides the following kind of components: 

• Sources parts bin (AC 

voltage source, VCC source, 

ground, battery, etc)  

• Basic parts bin (resistors, 

capacitors, transformers, 

switches, etc) 

• Diodes parts bin 

• Transistors parts bin 

• Analog ICs parts bin (op-

amps, etc) 

• Mixed ICs parts bin (ADCs, 

DACs, 555 timers, etc) 

• Digital ICs parts bin (AND, 

OR, adders, multiplexers, 

etc) 

• Indicators parts bin 

(voltmeter, ammeter, probe, 

displays, etc) 

• Controls parts bin (voltage 

differentiator, multiplier, 

etc) 

• Instruments parts bin (multimeter, oscilloscope, function generator, etc) 

• Miscellaneous parts bin (write data, textbox, etc) 

• Write data: This component allows you to save simulation results as an ASCII file.  

• Text Box: Use this to add descriptive text anywhere in a circuit. 

 

 

Figure 13.1: Tool bar and components 

 

file://///iMixed
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DESIGNING LOGIC CIRCUIT FOR A GIVEN LOGIC 

EXPRESSION 
 

Given Logic Expression:    BABAF .. +=  

 

Procedure 
 

1. From Logic Gates Parts Bin, drag and drop the required logic gates on the design 

area. Use Component Properties dialog box to customize these gates. 

2. Connect the terminal of these gates according to the given expression. Use additional 

connectors form the Basic Parts Bin if more than one wire needs to be connected at a 

single node. 

3. Drag and drop a probe from Indicators Parts Bin. Use Component Properties dialog 

box to customize the color and other properties of the probe. Connect this probe at the 

output terminal of the circuit to indicate results. 

4. Select four switches form Basic Parts Bin. Specify the key that controls the switch by 

typing its name in the Value tab of the Component Properties dialog box. For 

example, if you want the switch to close or open when digit ‘1’ is pressed, type 1 in 

the Value tab, then click OK. Assign different keys to all the switches. 

5. Connect the output terminals of the switches to each of the circuit inputs A, B, and C. 

6. Drag and drop VCC and Ground form the Sources Parts Bin. 

7. Connect VCC terminal to one end and Ground terminal to the other end of all the 

switches. 

8. Label the circuit properly using text boxes found in the miscellaneous parts bin. 

9. Run the circuit using the Activate Simulation switch. Use the keys you have assigned 

to the switches to toggle them between VCC and Ground connections, thus providing 

1 or 0 respectively to the inputs. Record the results as indicated by the probe for all 

possible combinations of 1s and 0s at the inputs. 

 

EWB Circuit 

 
Figure 13.2: Designed circuit on EWB 
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Observations 
 

A B C Expected Output Observed Output 

0 0 0   

0 0 1   

0 1 0   

0 1 1   

1 0 0   

1 0 1   

1 1 0   

1 1 1   

1 1 1   
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Lab Session 14 
 

OBJECT 
 

Demonstrating various components of a PC and their interconnection. 

 

COMPONENTS OF A DESKTOP/LAPTOP 
 

System Unit 

 

It is the main computer system cabinet in a PC, which usually houses the power supply, 

motherboard, and some storage devices. 

 

Mother Board 

 

It is the main circuit board in a microprocessor system. It normally includes the 

microprocessor chip (or CPU), main memory (RAM) chips, all related support circuitry, 

and the expansion slots for plugging in additional components. It is also known as system 

board. 

 

Read Only Memory (ROM) 

 

It is a type of memory in which instructions to perform operations critical to a computer 

are stored on integrated (chips) in permanent, non-volatile form. The instructions are 

normally recorded on the chips by the manufacturer. 

 

Main Memory (RAM) 

 

It is the name given to the integrated circuits (chips) commonly known as RAM(Random 

Access Memory) that make up main memory, which provides volatile temporary storage 

of data and program instructions that the CPU is using; data and instructions can be 

retrieved at random, no matter where they are located in main memory. RAM is used for 

storing operating system software instructions and for temporary storage of applications 

software instructions, input data, and output data.  

 

On the basis of pin configuration, two types of RAM chips are available in the market: 

• SIMM – Single Inline Memory Module, all pins are aligned on one side of the chip.  

• DIMM – Dual Inline Memory Module, pins are aligned on both sides of the chip. 

 

On the basis of internal cell design, two types of RAM are there: 

• DRAM – Dynamic Random Access Memory, made of capacitors, used for most main 

memories. 
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• SRAM – Static Random Access Memory, made of flip flops, used for some 

specialized purposes within the main memory. 

• SDRAM (synchronous DRAM) is a generic name for various kinds of dynamic 

random access memory (DRAM) that are synchronized with the clock speed that the 

microprocessor is optimized for. This tends to increase the number of instructions that 

the processor can perform in a given time. 

It is a special high-speed memory area that the CPU can quickly access. It comprises a 

small area of RAM created in addition to the computer’s main memory (RAM); a copy of 

the most frequently used data and instructions is kept in the cache so the CPU can look in 

the cache first, which makes the computer run faster. Cache memory is usually located 

right on the microprocessor chip. 

 

Hard Disk 

 

It is a direct access secondary storage device consisting of a rigid metal platter connected 

to a control spindle; the entire unit, including the read/write heads, is enclosed in a 

permanently sealed container. Hard disks store much more data than diskettes do. 

 

Compact Disk 

 

It is an optical disk whose data is laser-recorded by the disk manufacturer. The user 

cannot change it or write on the disk, he can only read the data. 

 

Processor Chip 

 

It is an integrated circuit (chip) containing the CPU circuitry for a microprocessor. CPU 

is the brain of the computer; the part of the computer composed of electrical circuitry 

directing most of the computer system’s activities. It consists of the control unit and the 

arithmetic/logic unit (ALU) connected by a bus. 

 

 

Parallel Ports 

 

A parallel port is a socket on the system unit for attaching peripheral devices that transmit 

8 bits simultaneously; used mainly for connecting printers. 

Devices: printers, computers and other devices that need relatively high bandwidth 

 

 
Figure 14.1 

Serial Ports 

 

A serial port is a socket on the system unit for connecting peripheral devices, such as a 

modem or a mouse, that transmit data serially, one bit after the other. 
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Figure 14.2 

Devices  Mouse with no PS2 and USB port computers & Modems. 

 

VGA Port 

 

A Video Graphics Array (VGA) connector is a three-row 15-pin DE-15 connector. The 

15-pin VGA connector was provided on many video cards, computer monitors, laptop 

computers, projectors, and high definition television sets. 

 
Figure 14.3 

HDMI Port 

HDMI (High-Definition Multimedia Interface) is 

a proprietary audio/video interface for transmitting uncompressed video data and 

compressed or uncompressed digital audio data from an HDMI-compliant source device, 

such as a display controller, to a compatible computer monitor, video projector, digital 

television, or digital audio device.[4] HDMI is a digital replacement for analog 

video standards. 

 
Figure 14.4 

 

USB PORTS: 

USB, short for Universal Serial Bus, is an industry standard that defines cables, 

connectors and communications protocols for connection, communication, and power 

supply between computers and devices. 

Devices  All type of connectors ,Mouse ,cell phones etc. 

 

 

 

 

https://en.wikipedia.org/wiki/Proprietary_hardware
https://en.wikipedia.org/wiki/Interface_(computing)
https://en.wikipedia.org/wiki/Uncompressed_video
https://en.wikipedia.org/wiki/Digital_audio
https://en.wikipedia.org/wiki/Display_controller
https://en.wikipedia.org/wiki/Visual_display_unit
https://en.wikipedia.org/wiki/Video_projector
https://en.wikipedia.org/wiki/Digital_television
https://en.wikipedia.org/wiki/Digital_television
https://en.wikipedia.org/wiki/Digital_audio
https://en.wikipedia.org/wiki/HDMI#cite_note-HDMIFAQ-4
https://en.wikipedia.org/wiki/Analog_video
https://en.wikipedia.org/wiki/Analog_video
https://en.wikipedia.org/wiki/Technical_standard
https://en.wikipedia.org/wiki/Communications_protocol
https://en.wikipedia.org/wiki/Computer
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System Clock/Timer 

 

Every microprocessor contains a system clock. It controls how fast all the operations 

within a computer take place. The faster the clock the faster the processing; clock speed 

in measured in megahertz. 

 

Power Supply 

 

It is the source of electrical power to components housed in the system unit of a PC. 

 

Data Cables 

 

It is the communication path linking several devices to the microprocessor for 

transferring data. 

 
Figure 14.5 

Power Cables 

 

It is the communication path linking several devices, including the microprocessor, to the 

power supply for provision of electrical power. 

 

Expansion Slot 

 

In a PC, an area within the system cabinet where expansion cards, such as color graphic 

adapter cards and expanded memory cards, can be inserted and plugged into the 

computer’s circuitry. 

 
Figure 14.6 

Display Screens  

 

Color display screen is one that can display up to 16.7 million colors, depending on the 

type of display screen and graphics adapter cards used. 
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Screens 

 

Video display screen is a device for viewing computer output. Two main types are:  

• Cathode ray tube (CRT) - also called monitor or screen. 

• Flat panel display - a type of display screen used on portable computers. They are 

much thinner, weigh less and use less power than CRTs. 

• An  LED display is a flat panel display, which uses an array of light-emitting 

diodes as pixels for a video display. Their brightness allows them to be used outdoors 

where they are visible in the sun store signs and billboards. 

• LCD (liquid crystal display) is the technology used for displays in notebook and other 

smaller computers. Like light-emitting diode (LED) and gas-plasma 

technologies, LCD allow displays to be much thinner than cathode ray tube (CRT) 

technology. 

 

 

Graphic Adapter Cards 

 

Graphics adapter card, also known as video display adapter is a circuit board in the 

system unit that determines the display screen’s resolution, number of colors, and how 

fast images appear. The card and the monitor must be compatible models. These cards are 

the expansion cards plugged into expansion slot in system cabinet that allows compatible 

monitor to display bit-mapped graphics. They must be used with appropriate software. 

 

Commonly use types of adapter cards are: 

• Color graphics adapter (CGA) - displays 4 colors as well as monochrome images. 

• Video graphics array (VGA) - displays 16 colors. 

• Super video graphics array (SVGA) - displays up to 256 colors at a very high 

resolution.  

• Extended graphics array (XGA) - supports up to 16.7 million colors at a very high 

resolution. 

     
Sound Cards 

 

Sound card is a circuit board in the system unit which helps producing sounds at the 

output devices. It plugs in to an expansion slot in the PC. 

 
Figure 14.7 

 

 

 

https://en.wikipedia.org/wiki/Flat_panel_display
https://en.wikipedia.org/wiki/Light-emitting_diode
https://en.wikipedia.org/wiki/Light-emitting_diode
https://en.wikipedia.org/wiki/Pixel
https://en.wikipedia.org/wiki/Video_display
https://en.wikipedia.org/wiki/Retailing
https://en.wikipedia.org/wiki/Signage
https://en.wikipedia.org/wiki/Billboard_(advertising)


Introduction to Computing ________________________                      Lab Session 14 
NED University of Engineering & Technology – Department of Computer & Information Systems Engineering 

 77 

Network Cards 

 

A network interface card, which is inserted into an expansion slot in a PC, enables the 

computer to send and receive messages on a LAN. 

 

Modem Cards 

 

Modem is a device for translating digital signals from a computer into analog signals for 

transmission over telephone lines and then back into digital signals again for processing, 

that is a modem must be hooked up at each end of the transmission. Modem stands for 

Modulator/Demodulator 

 

Math Coprocessor 

 

It is a specialized processor chip installed on the motherboard that helps the CPU process 

the mathematical calculations more quickly. 

 

EXERCISES 
 

1. Find and list various hardware and their configuration attached to your system.  

 

______________________________________________________________________ 

        

_______________________________________________________________________ 

        

_______________________________________________________________________ 

        

_______________________________________________________________________ 

        

_______________________________________________________________________ 

        

_______________________________________________________________________ 

        

_______________________________________________________________________ 

        

_______________________________________________________________________ 

        

_______________________________________________________________________ 
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_______________________________________________________________________ 

        

_______________________________________________________________________ 

2. Label the diagrams properly 

1. ___________________________________________ 

2.____________________________________________ 

3.____________________________________________ 

4.___________________________________________ 

5.____________________________________________ 

6.____________________________________________ 

7.____________________________________________ 

8.____________________________________________ 

9.____________________________________________ 

10.____________________________________________ 

11.____________________________________________ 

12.____________________________________________ 

13.____________________________________________ 

14.____________________________________________ 

15.____________________________________________ 

16.____________________________________________ 

17.____________________________________________ 

18.____________________________________________ 

____________________________________________ 

 

 

 

Figure 14.8 
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Figure 14.9 
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